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Resum

Nuestro principal objetivo es ampliar y validar una herramienta de simulación numérica
para resolver problemas electromagnéticos en el dominio de la frecuencia.
Para ello contamos con dos herramientas genéricas de cálculo ya realizadas. Una de -
ellas es el programa de pre y postproceso GiD. GiD es un programa gráfico destinado a la
definición y preparación de los datos de entrada necesarios en una simulación numérica,
ası́ como a la visualización de sus resultados. La otra es el módulo de cálculo ERMES
(acrónimo proveniente de: Electric field with Regularizad Maxwell Equations and Singular
elements), el cual resuelve las ecuaciones de Maxwell mediante el método de los elemen-
tos finitos (MEF).
Con estas herramientas lo primero que haremos será modificar el programa ERMES que
se integrará en GiD. Añadiremos nuevas funcionalidades a la interface que nos permi-
tan observar resultados como las gráficas de parámetros S de un dispositivo. Además,
ilustraremos las nuevas funciones de ERMES con varios ejemplos de validación y de-
mostración que verifiquen su adecuada implementación. Por último, se creará una docu-
mentación asociada que, más allá de su uso por profesionales del sector, también pro-
porcionará tutoriales básicos que los estudiantes pueden utilizar como herramienta de
aprendizaje.
Como resultado final se dispondrá de un módulo de cálculo desarrollado para poder rea-
lizar simulaciones electromagnéticas en tres dimensiones para el modelado de sistemas
basados en microondas.
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Overview

Our principal objective is to create a simulation computer tool for frequency domain elec-
tromagnetic propagation problems in three dimensions.
We dispose of two generic tools. One of them is the pre- and postprocess program GiD.
This is a graphic program, created for the definition and preparation of dates that will be
used for numerical simulations, and also for the visualization of its results. In the other
hand, we have a FEM (finite elements method) code called ERMES (Electric field with
Regularized Maxwell Equations and Singular elements). ERMES has been implemented
with the goal of provide a computing tool for the analysis, design and test of electromag-
netic devices, like transformers, motors, switches, phones, speakers, monitors, etc.
With all these, we get several results: first of all, we modify ERMES that we integrate in
GID. We add new functionalities to the interface that shows results as the S parameters.
Next, we illustrate the new functions of ERMES with examples that verify its good imple-
mentation. And, finally, we create an associated documentation that provides basic tuto-
rials to learn and improve in electromagnetism, very useful for students and professionals
of this area.
To sum up, we have a software package developed that can be able of electromagnetic
simulations in three dimensions for the model of microwave sistems.
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3.2. Introducci ón al electromagnetismo. . . . . . . . . . . . . . . . . . . . . . . 17
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C.1. Objetivos de la simulaci ón . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
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D.2. Descripci ón del ejemplo . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
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D.3.4. Establecimiento de los parámetros del problema . . . . . . . . . . . 17

D.3.5. Creación de la malla . . . . . . . . . . . . . . . . . . . . . . . . . . 17
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E.1. Objetivos de la simulaci ón . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
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APÉNDICE F. Capacitive Iris . . . . . . . . . . . . . . . . . . . . . . . . . 23
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CAPÍTULO 1. MOTIVACIÓN

Actualmente, el electromagnetismo presenta una serie de aplicaciones que abarcan todo
tipo de facetas de nuestra vida cotidiana. Una de estas aplicaciones es la propagación de
ondas, cuyo medio más común es el espacio, debido a sus ventajas en cuanto a coste e
infraestructuras. Sin embargo, este tipo de propagación requiere del uso de antenas que
emitan y reciban la información y de sistemas para su alimentación basados en guı́as de
ondas y lı́neas de transmisión. El amplio desarrollo de la telefonı́a móvil y la transmisión
por satélite ha provocado un aumento en la complejidad de dichas antenas y sistemas.

Disponemos de programas de simulación electromagnética dedicados a prever diagra-
mas de radiación y modelar dispositivos de microondas que son muy útiles a la hora de
construir antenas y sistemas asociados. Son aplicaciones que requieren gran potencia
de cálculo, ya que deben representarse las condiciones en las que la onda es recibida o
emitida por la antena o se propaga en el interior de la guı́a de onda, y esto implica que el
modelo del dispositivo debe disponer de suficientes puntos de cálculo como para recoger
fielmente su comportamiento.

Los análisis realizados implican la formulación de las ecuaciones de Maxwell para alta
frecuencia. De entre los diferentes métodos empleados predominan el Método de los Mo-
mentos (MoM), el Método de los Elementos Finitos (FEM), el método de las Diferencias
Finitas en el Dominio del Tiempo (FDTD) y los métodos asintóticos de alta frecuencia
(GTD, UTP, PO).

El método de los elementos finitos se basa en dividir el cuerpo, estructura o dominio del
problema en una serie de subdominios o elementos finitos. Estos elementos se componen
de una serie de puntos de cálculo llamados nodos, los cuales están separados entre si
por una distancia inferior a λ

10. Por tanto, como la distancia de los nodos depende de la
frecuencia, si aumenta la frecuencia de trabajo, también aumenta el número de puntos de
cálculo necesarios. Estas técnicas tienen numerosas aplicaciones y se emplean con éxito
en el estudio de otros dispositivos de telecomunicación. Ejemplos ilustrativos vendrı́an a
ser las cavidades de microondas o la propagación por cable.

El tema del proyecto interesa por múltiples factores, por un lado, profundizar en el electro-
magnetismo que es la base de la mayorı́a de medios de telecomunicación, por otro lado,
la simulación por ordenador, un gran avance que nos supone un gran ahorro de tiempo y,
por último, la creación de una documentación que pueda ayudar a otros estudiantes de la
materia a comprenderla mejor.
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CAPÍTULO 2. OBJETIVOS

El principal objetivo de este TFC es la ampliación y validación de una herramienta de simu-
lación por ordenador para problemas tridimensionales de propagación electromagnética
en el dominio de la frecuencia y la creación de una documentación asociada para su
manejo.

De entre la amplia gama de problemas a resolver, este trabajo de fin de carrera se enfo-
cará al estudio de los filtros de microondas.

El trabajo parte de dos herramientas genéricas de cálculo ya realizadas:

a) el programa de pre y postproceso GiD:

• es un programa gráfico, destinado a la definición y preparación de los datos
destinados a realizar una simulación numérica, ası́ como a la visualización de
sus resultados;

• permite la definición de la geometrı́a a estudiar, materiales que la componen,
las condiciones de contorno, y otros parámetros, como por ejemplo la estrate-
gia de resolución;

• realiza la creación de malla (para elementos finitos, diferencias finitas u otros
métodos) y transferencia de los datos asociados a la geometrı́a;

• permite la ejecución del análisis desde el propio GiD, como si todo fuese un
paquete único;

• dispone de comandos de postproceso, para la visualización de los resultados
de modo que sean fácilmente interpretables (por colores, curvas de nivel, eti-
quetas, vectores, gráficas, animaciones, etc.);

• es posible la extensión de la interface GiD mediante la creación de ventanas
propias usando el lenguaje Tcl/Tk.

b) ERMES, implementa las ecuaciones de Maxwell mediante el método de los elementos
finitos (MEF):

• permiten resolver problemas de propagación de ondas en el dominio de la
frecuencia;

• está en fase de estudio incluir el tratamiento de singularidades;

Ası́, el objetivo del trabajo dadas las condiciones de partida puede desglosarse en varios
puntos:

1. Realización de mejoras en la interface de ERMES. Añadimos una nueva funciona-
lidad que nos permitirá visualizar las gráficas de parámetros S de la estructura que
estemos estudiando;

2. Validación de una serie de ejemplos que verifiquen la adecuada implementación de
ERMES;
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3. creación de la documentación asociada que, además de su uso para profesionales
del sector, también proporciona tutoriales básicos que lo convierten en una herra-
mienta de aprendizaje y prueba para estudiantes de electromagnetismo;

Traduciendo dichos objetivos al plan de trabajo, que también se corresponde en buena
medida con el ı́ndice de esta memoria, se tienen los siguientes puntos:

1. definición de los datos de entrada, es decir, las especificaciones del problema sobre
el que se aplicará el programa;

2. creación de las ventanas de entrada de datos con GiD;

3. elaboración y selección de una serie de ejemplos de validación (con soluciones
teóricas bien conocidas, ya sean analı́ticas o provenientes de otros paquetes de
cálculo suficientemente contrastados) como son los ejemplos propuestos en los
anexos C, D y E, ası́ como algún otro ejemplo de demostración para ilustrar las
posibilidades del paquete como el ejemplo del anexo B (que también sirve como
manual de uso del programa) o el ejemplo del anexo F;

4. desarrollo y aplicación del bloque de cálculo sobre los ejemplos anteriormente se-
ñalados;

5. presentación de los resultados obtenidos y elaboración de la documentación aso-
ciada;

6. conclusiones finales que incluirán comparativa de los objetivos propuestos y logros
obtenidos, posibles aplicaciones de la herramienta en función del perfil de usuario
y futuras lı́neas de actuación;

Como resultado final se dispondrá de un módulo de cálculo desarrollado para poder rea-
lizar simulaciones electromagnéticas en tres dimensiones para el modelado de sistemas
basados en microondas.
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CAPÍTULO 3. ESTADO DEL ARTE.

En este capı́tulo realizaremos primero un breve estudio de la teorı́a electromagnética y
su aplicación a las guı́as de onda. Seguidamente veremos las bases teóricas del método
numérico empleado para obtener los campos y los parámetros de interés que caracterizan
las estructuras analizadas. Finalmente explicaremos las dos herramientas utilizadas en el
proyecto: GiD y ERMES.

3.1. Guı́as de onda.

Una guı́a de onda se puede definir como una estructura destinada a la propagación di-
rigida y acotada de radiación electromagnética. El medio dieléctrico en el que esta propa-
gación se produce puede estar limitado por un material conductor (microondas) u otro
dieléctrico (fibra óptica). Desde el punto de vista geométrico, las formas más comunes de
guı́a de onda tienen secciones rectangulares o cilı́ndricas.

Por lo general, el objetivo de las guı́as de onda es transmitir señales de información de
elevada frecuencia y que no podrı́an ser transmitidas por otros medios, debido a que
la transmisión no serı́a eficiente (para trasmitir señales ópticas a grandes distancias es
necesario emplear fibra óptica ya que por la atmósfera no serı́a viable), o bien porque
producirı́an interferencias en otros equipos, como es el caso de las ondas microondas
(frecuencias entre 0,3 y 300GHz).

Entre las principales ventajas de emplear guı́as de onda se encuentran el blindaje total de
la guı́a (lo que elimina las pérdidas por radiación), la ausencia de pérdidas en el dieléctrico
al no haber aisladores dentro, las menores pérdidas debidas al conductor al utilizarse
únicamente uno, la mayor capacidad para llevar señales de alta potencia y su simple
construcción (más sencilla que la de un coaxial por ejemplo).

Por el contrario, las principales desventajas asociadas a las guı́as de onda se deben a
que la instalación y operación es más compleja. Por ejemplo, se requieren radios de cur-
vatura mayores a una longitud de onda para evitar la atenuación. Además se debe sujetar
mediante soportes especiales para tener en cuenta la dilatación y contracción con la tem-
peratura. Finalmente, también se tienen que presurizar para mantener las condiciones de
uniformidad del medio interior.

3.2. Introducci ón al electromagnetismo.

3.2.1. Campos electromagn éticos y ecuaci ón de ondas.

Los fenómenos electromagnéticos se describen a nivel macroscópico mediante las ecua-
ciones de Maxwell. La forma de estas ecuaciones cuando suponemos que los campos
tienen una dependencia temporal sinusoidal se pueden escribir de forma fasorial. La no-
tación fasorial consiste en asumir que la dependencia en tiempo es armónica de tal modo
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que todos los campos toman la forma de vectores complejos con un término ejωt implı́cito
para describir la dependencia temporal. De este modo, un campo eléctrico sinusoidal
tomará la forma:

−→
E (x,y,z, t) = ℜ{−→E (x,y,z)ejωt}= A(x,y,z)cos(ωt +φ(x,y,z)) (3.1)

con
−→
E (x,y,z, t)la expresión del campo eléctrico en tiempo y espacio y

−→
E (x,y,z) el fasor

complejo asociado. El campo eléctrico tendrá una amplitud A(x,y,z) y una fase φ(x,y,z)
que se pueden obtener fácilmente a través de la parte real e imaginaria del fasor

A =
√

E2
R+E2

C (3.2)

φ = arctan(EC/ER) (3.3)

Las expresiones de las ecuaciones de Maxwell en notación fasorial en un medio dieléctrico
lineal, homogéneo e isótropo perfecto sin fuentes, como es el caso de la guı́a de ondas
que vamos a emplear, son las siguientes:

∇ ·−→E (x,y,z) = 0 (3.4)

∇×−→E (x,y,z) = − jωµ
−→
H (x,y,z) (3.5)

∇×−→H (x,y,z) = jωε−→E (x,y,z) (3.6)

∇ ·−→H (x,y,z) = 0 (3.7)

Siendo
−→
E el campo eléctrico,

−→
H el campo magnético, ε la permitividad eléctrica del

medio, µ la permeabilidad magnética del medio y ω la frecuencia en rad/s. Manipulan-
do matemáticamente las ecuaciones de Maxwell se obtienen las ecuaciones de onda de
los campos eléctrico y magnético:

∇2−→E (x,y,z) = −K2−→E (x,y,z) (3.8)

∇2−→H (x,y,z) = −K2−→H (x,y,z) (3.9)

Siendo K = ω
√

µε un valor denominado número de onda. Para hallar la solución de estas
ecuaciones tomaremos el eje Z como dirección de propagación de las ondas en el inte-
rior de la guı́a. Las direcciones X e Y serán por tanto las direcciones transversales a la
propagación. El tipo de soluciones que buscamos para las ecuaciones anteriores toman
la forma:

−→
E (x,y,z) =

−→
E (x,y)e− jβz (3.10)

−→
H (x,y,z) =

−→
H (x,y)e− jβz (3.11)

donde β es la llamada constante de propagación. La solución del tipo 3.10-3.11 se ca-
racteriza porque su fase depende linealmente de la coordenada en la dirección de propa-
gación mientras que su amplitud es independiente de la misma. Sustituyendo 3.10 y 3.11
en las respectivas ecuaciones de onda resulta:

∇2
t
−→
E (x,y)+(K2−β2)

−→
E (x,y) = 0 (3.12)
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∇2
t
−→
H (x,y)+(K2−β2)

−→
H (x,y) = 0 (3.13)

Donde el sı́mbolo ∇2
t = ∂2

∂x2 + ∂2

∂y2 es la laplaciana transversal [7]. Al término K2−β2 se

le denomina K2
c y representa el número de onda de corte. Este valor es muy importante

porque determinará a partir de que frecuencias se puede producir la propagación en la
guı́a de onda.

Por otro lado, manipulando matemáticamente las ecuaciones de Maxwell se pueden ob-
tener las relaciones entre las componentes transversales y longitudinales de los campos
en el interior de la guı́a de onda, lo que permite encontrar todas las componentes de los
campos en la guı́a a partir de las componentes longitudinales (Ez,Hz). La determinación
de estas componentes longitudinales se realiza a partir de las ecuaciones de ondas 3.12
y 3.13 aplicadas únicamente a las componentes longitudinales. Las nuevas ecuaciones
de onda obtenidas están completamente desacopladas:

∇2
t Ez(x,y)+(K2−β2)Ez(x,y) = 0 (3.14)

∇2
t Hz(x,y)+(K2−β2)Hz(x,y) = 0 (3.15)

A la hora de resolver 3.14 y 3.15 existen tres tipos de soluciones que pueden satisfacerlas.
En el primer caso se puede imponer Ez(x,y) = 0, en todos los puntos del interior de la
guı́a y obtener Hz(x,y) a partir de 3.15. Las soluciones obtenidas se denominan ondas
de tipo transversal eléctrico (TE) puesto que el campo eléctrico en el interior de la guı́a
sólo tiene componentes transversales a la dirección de propagación. En el segundo caso
tomamos Hz(x,y) = 0 en el interior de la guı́a y obtenemos Ez(x,y) a partir de 3.14. Las
ondas resultantes ahora son de tipo tranversal magnético (TM). Finalmente, si eligiésemos
simultáneamente que Ez = 0 y Hz = 0 tendrı́amos ondas de tipo transversal eléctrico y
magnético (TEM), solución inviable en guı́as rectangulares que es el caso que nos ocupa.

Es importante añadir que para que las soluciones de 3.14 y 3.15 sean únicas y fı́sicamente
posibles, se han de cumplir también las condiciones de contorno sobre la superficie con-
ductora de la guı́a de onda. Dichas condiciones de contorno se obtienen a partir de las
ecuaciones de Maxwell en forma integral y nos dicen que el campo eléctrico tangencial y
el campo magnético normal a la superficie de un conductor perfecto han de ser nulos.

3.2.2. Modos TE

Consideramos una guı́a de onda rectangular en dirección Z con unas dimensiones a y b
en los ejes X e Y respectivamente. Resolviendo la ecuación de ondas 3.15 sujeta a las
condiciones de contorno (Ver anexo A) se obtiene el siguiente resultado para la compo-
nente longitudinal del campo magnético:

Hz(x,y) = H0cos

(
mπ
a

x

)
cos

(
nπ
b

y

)
(3.16)

Esta solución corresponde a un modo genérico TEmn, donde los subı́ndices se relacionan
con el ritmo de variación transversal de los campos, en X e Y respectivamente. Además,
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se obtiene el valor para el número de onda de corte:

K2
c = K2−β2

mn =
(

mπ
a

)2

+
(

nπ
b

)2

→ βmn =

√
ω2µε−

(
mπ
a

)2

−
(

nπ
b

)2

(3.17)

Esta expresión, que relaciona la constante de propagación de cada modo con la frecuen-
cia nos indica cual es la frecuencia mı́nima necesaria para que se produzca propagación
en la guı́a, ya que para ello es necesario que β sea real.

La principal conclusión hasta ahora es que dentro de la guı́a de ondas existen varias
soluciones posibles en forma de modos de propagación. Esos modos forman un conjunto
discreto de soluciones que se obtienen individualmente dando valores enteros a m y n. La
constante de propagación βmn es diferente para cada uno de estos modos.

3.2.3. Modos guiados y en corte

De la ecuación 3.17 podemos comprobar que la constante de propagación se manten-
drá real siempre que:

ω2µε ≥ π2(
m2

a2 +
n2

b2)→ f >
vp

2π

√(
mπ
a

)2

+
(

nπ
b

)2

(3.18)

Siendo f la frecuencia de la señal en Hertzios y vp = 1/
√

µε la velocidad de propagación
en el dieléctrico. Esta expresión nos indica que para unos valores de m y n, la frecuencia
de la señal ha de estar por encima de una determinada frecuencia de corte para que se
produzca la propagación de la onda. Si no se satisface esta condición, la constante de
propagación βmn tomará un valor imaginario puro y el término de propagación del modo
e− jβz se convierte en un término de atenuación e−αz. Como consecuencia, la onda no se
podrá propagar por la guı́a sino que se irá amortiguando en la dirección Z y se extinguirá.
Por lo tanto, para un modo cualquiera determinado por sus valores m y n, existirá una
frecuencia mı́nima, fcmn, llamada frecuencia de corte, por debajo de la cual βmn pasa a
ser imaginaria, y el modo no podrá propagarse. A un modo en estas condiciones se le
llamará modo en corte. En cambio, aquellos modos cuya βmn sea real permiten transmitir
la señal a lo largo de la guı́a y se llaman modos guiados.

La frecuencia de corte de un modo puede escribirse como:

fcmn =
1

2
√

µε

[
m2

a2 +
n2

b2

] 1
2

(3.19)

Otro parámetro de interés es la longitud de onda de la guı́a, que se define como la dis-
tancia entre dos planos de fase consecutivos. Todas las componentes no nulas de campo
eléctrico o magnético repiten su fase cada distancia recorrida igual a:

λmn =
2π
βmn

(3.20)
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3.2.4. Modo fundamental TE 10

Se denomina modo fundamental o modo dominante a aquel cuya frecuencia de corte es
menor. Si partimos de una frecuencia elevada con numerosos modos excitados en la guı́a,
y vamos disminuyendo paulatinamente la frecuencia, será el último modo en desaparecer
(en entrar en corte). A partir de la ecuación (3.19), y si asumimos que las dimensiones
transversales de la guı́a cumplen la relación a > b, podemos ver que el último modo en
entrar en corte es el m=1,n=0. Por lo tanto el modo fundamental es el TE10.

La forma de los campos en el interior de la guı́a de ondas para el modo TE10 se obtiene
a partir de las ecuaciones para obtener los campos transversales a partir de los longitudi-
nales del anexo A y de las ecuaciones 3.1, 3.10, 3.11 y 3.16:

Hz(x,y,z, t) = H0cos

(
π
a

x

)
cos(ωt−β10z) (3.21)

Ey(x,y,z, t) =
jωµH0

(ω2µε−β2)
π
a

sin

(
π
a

x

)
cos(ωt−β10z) (3.22)

Hx(x,y,z, t) =
jβH0

(ω2µε−β2)
π
a

sin

(
π
a

x

)
cos(ωt−β10z) (3.23)

De estas ecuaciones se desprenden varias conclusiones importantes:

1. El campo eléctrico solo tiene componente en el eje Y.

2. Todos los valores dependen únicamente de x para un z y t fijos.

3. El máximo del campo eléctrico se obtendrá en el punto medio de la guı́a (valor
máximo del seno), siendo nulo en los extremos.

Figura 3.1: Forma de propagación del modo TE10

Para ampliar conocimientos sobre electromagnetismo son muy útiles los libros que se
indican en la bibliografı́a [7] y [8].

3.3. Métodos num éricos

La tecnologı́a moderna está, en gran medida, basada en sistemas electromagnéticos.
Las telecomunicaciones (antenas, guı́as de onda) o el campo de la diagnosis médica
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(resonancia magnética) son sólo algunos ejemplos de áreas que se han beneficiado de
nuestro conocimiento de electromagnetismo.

Pero aunque los principios del electromagnetismo son bien conocidos, sus aplicaciones a
situaciones prácticas siguen estando aún poco desarrollados y pocas veces pasan de los
métodos analı́ticos. Estas complicaciones vienen, muchas veces, debidas a geometrı́as
intrincadas o materiales de composición compleja. Afortunadamente, estas dificultades
pueden superarse con la ayuda del electromagnetismo computacional, una rama de la
simulación numérica dedicada al estudio de las ecuaciones de Maxwell.

El rango de aplicaciones del electromagnetismo (desde campo estáticos hasta radiación)
se ve reflejado en la amplia variedad de métodos numéricos disponibles. La clasificación
principal serı́a la que nos muestra el cuadro 3.1.

Métodos Rápido, preciso y fácil de implementar FDTD-Finite Difference Time Domain

diferenciales pero limitado cuando se tratan FDFD-Finite Difference

geometrı́as complejas Frequency Domain

Métodos Preciso y excelente con MoM-Method of Moments

varacionales geometrı́as complejas BEM-Boundary Element Method

pero costoso FEM-Finite Element Method

computacionalmente

Métodos Los más rápidos y que menos carga GO-Geometric Optics

asintóticos computacional necesitan pero se GTD-Geometric Theory of Diffraction

basan en aproximaciones UTD-Uniform Theory of Diffraction

UAT-Uniform Asymptotic Theory

PTD-Physical Theory of Diffraction

Métodos Mezcla de dos o más métodos, cuentan FEM-MoM

hı́bridos con las ventajas de aunar las partes FDTD-FEM

más caracterı́sticas de cada método y GTD-FEM

minimizar sus puntos débiles

Cuadro 3.1: Métodos numéricos

Estos son sólo algunos de las métodos numéricos más usados en electromagnetismo. En
la actualidad, se están desarrollando otros métodos más rápidos y eficientes. Nosotros
nos centraremos en el Método de los Elementos Finitos (MEF, en español o FEM, en
inglés), que es el que utiliza nuestro programa para resolver los problemas.

3.3.1. Método de los Elementos Finitos

El método de los elementos finitos es un método de aproximación de tal forma que:

• El contı́nuo se divide en un número finito de partes, “elementos”, cuyo compor-
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tamiento se especifica mediante un número finito de parámetros asociados a cier-
tos puntos caracterı́sticos denominados “nodos”. Estos nodos son los puntos de
unión de cada elemento con sus adyacentes. Al conjunto de todos estos nodos lo
llamaremos malla.

• La solución del sistema completo sigue las reglas de los problemas discretos. El
sistema completo se forma por ensamble de los elementos.

• Las incógnitas del problema dejan de ser funciones matemáticas y pasan a ser el
valor de estas funciones en los nodos.

• El comportamiento en el interior de cada elemento queda definido a partir del com-
portamiento de los nodos.

El MEF, por lo tanto, se basa en transformar un cuerpo de naturaleza continua en un
modelo discreto aproximado, esta transformación se denomina discretización del modelo.
El conocimiento de lo que sucede en el interior de este modelo del cuerpo aproximado,
se obtiene mediante la interpolación1 de los valores conocidos en los nodos. Es por tanto
una aproximación de los valores de una función a partir del conocimiento de un número
determinado y finito de puntos.

Una importante propiedad del método es la convergencia, si se consideran particiones
de elementos finitos sucesivamente más finas la solución numérica calculada converge
rápidamente hacia la solución exacta del sistema de ecuaciones.

Podemos ampliar conocimientos sobre los métodos numéricos en el libro [9] de la biblio-
grafı́a, y respecto al MEF, consultar el capı́tulo 5 (“El método de los elementos finitos”) de
[12].

3.4. Herramientas existentes

En este apartado vamos a explicar en qué consisten y como se utilizan las herramientas
ya existentes que usamos en el proyecto.

3.4.1. GID

GiD es un programa gráfico, destinado a la definición y preparación de los datos destina-
dos a realizar una simulación numérica, ası́ como a la visualización de sus resultados.

La creación de los datos implica la definición de la geometrı́a a estudiar, los materiales
que la componen, las condiciones de contorno, y otros parámetros, como por ejemplo la
estrategia de resolución.

1Interpolar: calcular el valor aproximado de una magnitud en un intervalo cuando se conocen algunos de
los valores que toma a uno y otro lado de dicho intervalo
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El programa se encarga de crear una malla (para elementos finitos, diferencias finitas u
otros métodos) y transferirle los datos asociados a la geometrı́a. La ejecución del análisis
puede realizarse desde el propio GiD, como si todo fuese un paquete único.

El postproceso consiste en la visualización de los resultados de modo que sean fácil-
mente interpretables. Pueden hacerse visualizaciones por colores, curvas de nivel, eti-
quetas, vectores, gráficas, animaciones, etc. Una caracterı́stica esencial de GiD es que
no está especializado en un tipo de análisis, a priori GiD no conoce ningún material o
condición, hasta que no se carga un ”tipo de problema”.

Cualquier usuario puede crear su “tipo de problema” particular, de modo que GiD conozca
la sintaxis de su programa de simulación particular.

Además un usuario avanzado puede extender la interface de GiD creando sus propias
ventanas mediante el lenguaje Tcl/Tk y personalizar el aspecto de GiD.

3.4.2. ERMES

ERMES es un paquete de simulación electromagnética que usa el método de los elemen-
tos finitos (MEF).

Está dirigido a aquellos estudiantes, ingenieros o investigadores que necesitan una platafor-
ma computacional robusta tal que, por un lado, ayude a entender la teorı́a electromagnética
viendo qué sucede y, por otro lado, les permita superar los lı́mites del cálculo analı́tico,
consiguiendo fácilmente la resolución de un problema real complejo.

Sin embargo, ERMES está lejos de ser una herramienta compleja por su integración en
GiD, programa que le permite asignar fácilmente los parámetros requeridos por una geo-
metrı́a concreta.
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CAPÍTULO 4. ESPECIFICACIONES DEL
PROBLEMA

Nuestro objetivo final es modelar una estructura fı́sica desde un punto de vista electro-
magnético. Dicho modelado consiste en el estudio de la propagación de los campos en
la estructura y la obtención de los parámetros S de la misma. Estos parámetros permiten
caracterizarla como un dispositivo con un puerto de entrada y uno o varios de salida.

Nuestro problema consta de una serie de parámetros que hemos de especificar, como
son la geometrı́a, los materiales de que está compuesto y las condiciones de contorno,
que le iremos asignando con GiD. Por último, habrá que aplicar en la estructura el modo
de resolución escogido.

En este capı́tulo, explicaremos de forma genérica que párametros tendremos que aplicar
en un caso general y como resolverlo. En caso de duda, podemos mirar el anexo B en el
que se desarrolla un ejemplo paso a paso a modo de tutorial.

Para empezar a trabajar con GiD primero tenemos que cargar la geometrı́a del problema
y su “Problem type” asociado, en este caso ERMES, como se indica en la figura 4.1.
En esta figura, vemos la barra de herramientas del programa, formada por una serie de
botones que son los que tendremos que ir usando, en sentido descendente, para aplicar
los parámatros del problema y su forma de resolución. Por si fuera necesaria, ERMES
cuenta con una pequeña ayuda y soporte web.

Figura 4.1: Como cargar el “problem type”
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4.1. PREPROCESO

Se entiende por preproceso al conjunto de etapas previas al cálculo en sı́ de las ecua-
ciones fı́sicas a resolver por el simulador y que se corresponden con la entrada de datos
del problema.

4.1.1. Materiales

Aplicamos los diferentes materiales que correspondan a las distintas partes de la pieza,
indicando los coeficientes de “Conductividad eléctrica”, “Permitividad eléctrica” y “Perme-
abilidad magnética”.

Figura 4.2: Ventana de asignación de materiales

4.1.2. Coeficientes de contorno

Asignamos una serie de coeficientes que indican los puertos, el modo de transmisión y
la forma de transmisión. A cada puerto le otorgamos un número para distinguir unos de
otros ası́ como las coordenadas de tres puntos que definen la superficie de cada puerto.
Uno que tomaremos como referencia, otro que indique la altura del puerto y un tercero
que indique su anchura. Gracias a estos puntos el programa sabrá como se transmiten
los modos.

4.1.3. Condiciones el éctricas y de contorno

En este apartado asignamos las condiciones de contorno necesarias para que el méto-
do de elementos finitos pueda resolver las ecuaciones de onda de forma única. Dichas
ecuaciones de contorno se obtienen a partir de las ecuaciones de Maxwell en forma inte-
gral cuando se aplican sobre un conductor eléctrico o magnético perfecto. Ası́, si estamos
ante una guı́a de onda ideal, la superficie metálica de la misma se podrá tratar como un
conductor eléctrico perfecto (PEC:Perfect Electric Conductor). Por su parte, los puertos
de la estructura se considerarán que son conductores magnéticos perfectos (PMC:Perfect
Magnetic Conductor). En el caso PEC, se cumple que la componente del campo eléctrico
tangente y la componente de campo magnético normal a la superficie de la guı́a serán
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nulas, mientras que en el caso PMC la componente de
−→
E y

−→
H que se anulan son la per-

pendicular y tangente al puerto respectivamente. Esto, en notación matemática serı́a:

PEC ≡ n̂×−→E = 0

PEC ≡ n̂·−→H = 0

PMC ≡ n̂·−→E = 0

PMC ≡ n̂×−→H = 0

(4.1)

Si no queremos emplear estos casos ideales pero si que conocemos alguna de las com-
ponentes del campo eléctrico, fijaremos el valor conocido en la geometrı́a (Ex, Ey y Ez).

Figura 4.3: Condiciones eléctricas Figura 4.4: Condiciones de contorno

Las condiciones de contorno o Boundary conditions permiten definir los puertos de en-
trada y salida además de las componentes de campo lejano (Far Field Condition) en las
superficies que lo definan, cuando éstas sean necesarias.

4.1.4. Modos de proyecci ón

En esta ventana indicamos el plano en el que observaremos los resultados obtenidos.
Estos planos no tienen porqué coincidir con los puertos de entrada y salida del dispositivo,
si no que pueden estar desplazados para poder ver el campo eléctrico en el interior de la
estructura.

4.1.5. Estrategia de resoluci ón

Para resolver el problema necesitamos conocer varios parámetros como los siguientes:

Frecuencia del problema:(Hz): indica la frecuencia usada en el problema. En caso de
que esté activada la opción Frecuency sweep el problema realizará un barrido entre las
frecuencias que nosotros le indiquemos.

Solvers:
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Figura 4.5: Frecuencias Figura 4.6: Solvers

Los campos siguientes tienen relación con la resolución de las ecuaciones lineales obtenidas
con el método de los elementos finitos y, básicamente, definen la precisión de las magni-
tudes fı́sicas buscadas (el campo eléctrico) y el número máximo de iteraciones permitidas
para obtenerlas. Esto se debe a que los métodos iterativos parten de una solución inicial
aproximada que, si todo va bien, converge en la solución real en sucesivas iteraciones.

Max Iterations: indican el número máximo de iteraciones que realiza el algoritmo para re-
solver el sistema de ecuaciones. Seleccionando la opción ‘‘Custom’’, este valor puede
modificarse manualmente. Pese a que no hay lı́mites para este valor, un problema mal
definido puede acarrear excesivas iteraciones y, por tanto, que el programa emplee de-
masiado tiempo en resolverlo.

Tolerance: indica el valor del error relativo permitido. Como en el caso anterior, selec-
cionanado la opción ‘‘Custom’’, este valor puede ser modificado. ERMES resuelve un

sistema de ecuaciones lineales iterativamente minimizando el error ‖Ax−b‖
‖b‖ hasta que al-

canza un valor por debajo de la tolerancia especificada.

4.1.6. Resultados

Podemos obtener distintos resultados que hay que indicar al programa previamente a la
simulación. Por ejemplo, marcaremos la opción de campo eléctrico en el dominio temporal
si, después, queremos animar la propagación de dicho campo en el tiempo.

Figura 4.7: Resultados en el dominio del
tiempo

Figura 4.8: Resultados en el dominio de la
frecuencia
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4.1.7. Mallado

El método de elementos finitos, que es en el que está basado nuestro programa, se basa
en una discretización de la figura en nodos unidos entre sı́ por una malla (mirar capı́tulo 3).
En este apartado explicaremos diversas formas de generar dicha malla y diversos factores
ha tener en cuenta antes de hacerlo.

El programa intentará usar el menor número de elementos para encajar en la geometrı́a
con un error menor del 1 %, pero esto depende completamente del modelo geométrico
ası́ que debe ser verificado. Usar un gran número de elementos aumenta el tiempo nece-
sario para generar la malla ası́ como el tiempo de computación. Por esta razón, el usuario
puede modificar, tanto el tamaño medio de los elementos, como definir ciertas áreas con
elementos de diferentes tamaños (asignados sobre entidades geométricas).

A la hora de elegir el tamaño de los elementos de la malla, hemos de tener en cuenta que
el programa debe disponer de suficientes puntos de cálculo como para poder resolver
el problema. Atendiendo a las consideraciones geométricas, estos puntos deben encon-
trarse a una distancia tı́pica menor que λ

10 para que el modelado de la estructura por la
malla sea adecuado.

Los detalles concretos sobre la generación de la malla se pueden encontrar en la ayuda
de GiD, pero es importante recordar dos parámetros importantes:

1. tamaño medio de los elementos: valor necesario para crear la malla;

2. tamaño especı́fico de los elementos: tamaño aplicado sobre diferentes entidades
geométricas (puntos,lı́neas,superfices) o por criterio adaptativo (By geometry, By
cordal error, Correct sizes);

Además, también podemos refinar el mallado en los puntos, lı́neas o superficies que nos
interese. De esta forma, podemos mejorar la precisión de nuestros cálculos.

Figura 4.9: Malla con concentración de elementos alrededor de un punto

El número de nodos será mucho mayor en la zona donde hemos seleccionado las lı́neas
con un tamaño de elementos menor y el cálculo será más preciso en dicha zona.

Para ver un ejemplo detallado de cómo mallar distintas zonas con tamaños de elementos
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distintos, ir al ejemplo del anexo B, el cual, además, está explicado a modo de manual
para ver paso a paso todo el proceso de simulación y su resultado.

4.1.8. Cálculo

Una vez el problema está definido (geometrı́a, condiciones, etc), el programa tiene que
resolver las correspondientes ecuaciones a través del módulo ERMES.

Todo el proceso puede ser monitorizado usando la ventana ‘‘Calculate’’→ ‘‘Calculate
window’’. En el ‘‘Process window’’ aparece listado el problema que se está desarro-
llando. Mientras que, en ‘‘View process info’’ aparecen mensajes informando sobre
el desarrollo del problema (datos leı́dos, iteraciones, progreso computacional,etc.).Esta
ventana es especialmente útil para identificar situaciones anormales (no convergencia,
resultados no esperados o incorrectos).

Si aparece algún mensaje de error, quiere decir que ha habido algún problema que impide
realizar la simulación, y todos los datos (materiales asignados, condiciones de contorno)
deben ser revisados, ya que un error tı́pico es definir mal el problema. Si el problema
persiste y no converge, esto también puede ser debido a que el número máximo de itera-
ciones siguen siendo pocas o a que la tolerancia que le hemos indicado es muy estricta y
el número de iteraciones necesarias es demasiado elevado.

4.2. POSTPROCESO

En este apartado veremos cómo visualizar distintos resultados una vez realizados los
cálculos por ERMES y resuelto el problema. Este postproceso se realiza desde el propio
GiD.

4.2.1. Visualizaci ón de resultados

Hay muchas posibilidades de visualización y la explicación de todas ellas las podemos
encontrar en la ayuda de GiD [3].

Las ventanas más útiles para visualizar resultados son las que nos muestran las figuras
4.10, 4.11 y 4.12.

La primera ventana (‘‘View Style’’) muestra la composición del modelo usando la
definición de capas y la interpretación del estilo (contorno, lı́neas, cuerpo). La segunda
(‘‘View Results’’) muestra las magnitudes fı́sicas a visualizar, por ejemplo, en el
caso de ERMES:

• Componente real del campo eléctrico;

• Componente imaginaria del campo eléctrico;
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Figura 4.10: Estilo Figura 4.11: Vista de los
resultados

Figura 4.12: Animación de
los resultados

• Módulo del campo eléctrico;

Estos resultados solo se pueden visualizar si el tiempo seleccionado es cero. Si queremos
ver los resultados en función del tiempo, tenemos que seleccionar un tiempo distinto de 0
y podremos ver, en el caso de ERMES:

• Campo eléctrico en el dominio temporal;

Solo en este caso es útil la tercera ventana (‘‘Animate’’) . Ésta ventana permite al
usuario animar los resultados y ver su variación a lo largo del tiempo.

4.2.2. Parámetros de Scattering

Los parámetros Si j nos muestran la relación entre las amplitudes de las ondas transmiti-
das o reflejadas y las amplitudes de las ondas incidentes.

Por ejemplo, S11 y S21 indican cuanta señal se refleja en el puerto 1 y cuanta se transmite
al puerto 2 cuando incide una señal en el puerto 1 y el puerto 2 está perfectamente
adaptado (no hay reflexiones tras él ni fuentes). Respectivamente, S22 y S12 indican cuanta
señal se refleja en el puerto 2 y cuanta se transmite al puerto 1 cuando incide una señal
en el puerto 2 y el puerto 1 está perfectamente adaptado (no hay reflexiones tras él ni
fuentes).

Finalmente, cuando los dispositivos presentan elevadas simetrı́as (como es el caso de los
que hemos analizado en este trabajo), algunos de los parámetros de scattering coincidirán
entre ellos.
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Figura 4.13: Gráfica de los parámetro S
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CAPÍTULO 5. PROPUESTA DE EJEMPLOS

En este capı́tulo, propondremos una serie de ejemplos sobre los que aplicar el programa y
observar los resultados. Estos ejemplos se basan en guı́as de onda de sección rectangular
sobre los que estudiaremos la propagación del campo eléctrico en su interior y las gráficas
de parámetros S en posteriores capı́tulos.

Estos ejemplos son:

5.1. Inductive Iris

Se trata de una guı́a de onda rectangular con un estrechamiento en el centro llamada iris.
Este primer ejemplo nos puede servir para demostrar que la solución de campo eléctrico
proporcionada por el programa se corresponde con las soluciones anaĺıticas. Además,
veremos cómo afecta este iris al comportamiento de la guı́a y cómo un cambio en la
geometrı́a o en el tamaño de los elementos de la malla puede modificar los resultados.

Figura 5.1: Inductive Iris

Este ejemplo está desarrollado paso a paso en el anexo B para que pueda servir también
de tutorial.

5.2. TJuntion

Este caso es una guı́a de onda rectangular con un puerto de entrada y dos de salida.
Aquı́ veremos qué sucede en los diferentes puertos cuando excitamos uno de ellos con
el modo fundamental. Este ejemplo también nos sirve para verificar que la gráfica de
parámetros S obtenida por ERMES coincide con las soluciones obtenidas por otros pro-
gramas.

Aunque veremos los resultado en el capı́tulo 6, tenemos el ejemplo completo en el anexo
C.
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Figura 5.2: TJuntion

5.3. Guı́a de onda con una transici ón de altura constante

Este ejemplo muestra también una guı́a de onda rectangular pero con una discontinuidad
diferente, en este caso la guı́a sufre un ensanchamiento. Además, estudiaremos los casos
en el que los puertos de entrada y salida estén más cerca y más lejos del momento en
que se produce el ensanchamiento. En este caso podremos observar la influencia de los
modos evanescentes en las gráficas de los parámetros S.

Figura 5.3: Transición de altura constante

De nuevo podemos ir a los anexos (al anexo D en este caso) para ver el ejemplo desarro-
llado.

5.4. Guı́a de onda con seis iris inductivos

Esta guı́a es una estructura con seis iris inductivos. Estos iris le darán unas caracterı́sticas
muy especiales a la guı́a que provocarán resonancias en la misma. Este ejempo nos
puede servir para validar las gráficas de parámetros S del programa que se corresponden
con las gráficas obtenidas por otro programa. Para ver el ejemplo completo ir al anexo E.
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Figura 5.4: Guı́a de onda con seis iris inductivos

5.5. Capacitive Iris

Éste es un caso particular de guı́a de onda en el que se produce un estrechamiento en la
parte central de la misma pero, al contrario que en el Inductive Iris que mantenı́a la altura
constante, en este caso lo que no cambia es el ancho de la guı́a. En este ejemplo, lo que
veremos es un caso que no podemos solucionar.

Figura 5.5: Capacitive Iris

Para ver el desarrollo completo de este ejemplo ir al anexo F.
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CAPÍTULO 6. DISEÑO DE LA HERRAMIENTA

En este capı́tulo exponemos el núcleo principal del trabajo, que contiene la principal con-
tribución de la autora a este programa de simulación, que es la ampliación de la interface
del programa ERMES y la validación de los ejemplos propuestos en el capı́tulo 5.

6.1. Ampliaci ón de ERMES

Hemos realizado algunas mejoras en la interfaz de ERMES que le permitan obtener
nuevos resultados. Se trata de la obtención de las gráficas de parámetros S. Hagamos
primero una pequeña introducción a estos parámetros para saber qué son.

Parámetros S:

Los parámetros de scattering (también conocidos como parámetros de dispersión, de
distribución o simplemente parámetros S) son una serie de parámetros presentados en
forma matricial que permiten modelar un dispositivo de N puertas. La ventaja de estos pa-
rámetros es que permiten ver de forma intuitiva el comportamiento del dispositivo respecto
a ondas incidentes, transmitidas y reflejadas. Otra ventaja de emplear estos parámetros
para caracterizar un dispositivo es la posibilidad de obtenerlos a partir de medidas en
frecuencia, puesto que se pueden conseguir a partir de relaciones de onda estacionaria,
medidas de máximos y mı́nimos de campo eléctrico y de potencia.

En la figura 6.1. vemos un dispositivo de dos puertas que queremos modelar mediante
parámetros S. Para ello consideramos que sobre el dispositivo se aplican unas ondas de
potencia incidentes en los puertos. Estas ondas incidentes (ai) producirán ondas refle-
jadas y ondas transmitidas (bi). La relación entre estas ondas reflejadas/transmitidas y las
ondas incidentes constituyen los parámetros S.

La matriz de parámetros de scattering asociada a la figura anterior tendrá la forma:

Con S11 indicando la relación entre la onda reflejada en el puerto 1 (b1) y la onda incidente
en el mismo (a1) cuando el puerto 2 está perfectamente adaptado (a2 = 0), S21 la relación
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entre la onda transmitida en el puerto 2 (b2) y la onda incidente en el puerto 1 (a1) cuando
el puerto 2 está perfectamente adaptado (a2 = 0), S12 la relación entre la onda transmitida
en el puerto 1 (b1) y la onda incidente en el puerto 2 (a2) cuando el puerto 1 está per-
fectamente adaptado (a1 = 0) y S22 la relación entre la onda reflejada en el puerto 2 (b2)
y la onda incidente en el mismo puerto (a2) y el puerto 1 está perfectamente adaptado
(a1 = 0).

Dicho de otro modo, S11 y S21 indican cuanta señal se refleja en el puerto 1 y cuanta se
transmite al puerto 2 cuando incide una señal en el puerto 1 y el puerto 2 está perfecta-
mente adaptado (no hay reflexiones tras él ni fuentes). Respectivamente, S22 y S12 indican
cuanta señal se refleja en el puerto 2 y cuanta se transmite al puerto 1 cuando incide una
señal en el puerto 2 y el puerto 1 está perfectamente adaptado (no hay reflexiones tras él
ni fuentes).

Finalmente, cuando los dispositivos presentan elevadas simetrı́as (como es el caso de los
que hemos analizado en este trabajo), algunos de los parámetros de scattering coincidirán
entre ellos.

Una de las tareas llevadas a cabo en el proyecto a sido la modificación de la interfaz de
ERMES de tal modo que, en el postproceso, aparezca un nuevo botón que nos muestre las
gráficas de parámetros S tal y como muestra la figura 6.1. Este proceso está desarrollado
en lenguaje TCL/TK y el código completo se encuentra en el anexo G.

Figura 6.1: Gráfica de los parámetro S

También hemos creado paralelamente la ayuda del programa en lenguaje html.
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Figura 6.2: Página principal de la ayuda de ERMES

6.2. Validaci ón de los ejemplos

En este apartado vamos a validar los ejemplos propuestos en el capı́tulo 5. En esta vali-
dación comprobaremos dos cosas: por un lado, cómo se propaga el campo eléctrico a lo
largo de la guı́a de onda, y por otro, analizaremos las gráficas de parámetros S, que nos
darán información sobre el dispositivo que estamos estudiando. Además, compararemos
los resultados obtenidos por ERMES con los que obtenemos de otro software llamado
FEST3D cuyos resultados nos servirán de referencia. FEST (Fullwave Electromagnetic
Simulation tool) es una herramienta de software enfocada al diseño y simulación de cir-
cuitos de microondas.

6.2.1. Inductive Iris

En este ejemplo, medimos el campo eléctrico en f = 13GHz, que es una frecuencia li-
geramente superior a la frecuencia de corte, y escogemos un tamaño máximo de los
elementos de la malla de 0,001m (valor inferior a λ/10). Observamos el resultado obtenido
en la figura 6.3. También podemos ver como varı́a ese resultado si alejamos los puertos
al doble de distancia (figura 6.4), es decir, que si la distancia entre los puertos antes era
de 66mm ahora será de 130mm, o si los acercamos reduciendo esa distancia a la mitad
(figura 6.5, nueva distancia entre los puertos=33mm).

Observamos como el modo que se propaga a lo largo de las guı́a es el modo fundamental
TE10. Podemos comprobar como la forma del campo coincide con lo dicho en la teorı́a
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Figura 6.3: Variación del campo eléctrico

Figura 6.4: |E| si alejamos los puertos

Figura 6.5: |E| si acercamos los puertos

(Capı́tulo 3) para el modo fundamental. Dicho campo tiene una forma senoidal que pode-
mos ver si hacemos un corte transversal en la guı́a porque éste se anula en los bordes de
la guı́a y alcanza su máximo valor en el centro. La forma de los campos es idéntica para
todas las longitudes de guı́a probadas.

Ahora hacemos el barrido de frecuencias entre 9 y 15GHz para ver las gráficas de pará-
metros S y las comparamos con los resultados del FEST que tomamos como referencia.
Con el mallado anterior (todos los elementos igual) no nos da buenos resultados, como
se ve en la figura 6.7, ası́ que mallamos más fino las lı́neas que forman el iris puesto que
ésta es la zona problemática. En este caso el tamaño de los elementos en las lı́neas que
forman el iris será 0,0001m y en el resto será 0,001m.
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Figura 6.6: Comparativa de las gráficas de parámetros S con mallado grueso

Figura 6.7: Comparativa de las gráficas de parámetros S,resolvemos el mismo ejemplo
con ERMES y FEST (figura 6.3)

Todas las gráficas son idénticas, esto quiere decir que hemos resuelto bien el problema.
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Figura 6.8: Comparativa de las gráficas de parámetros S de FEST con la figura 6.4

Figura 6.9: Comparativa de las gráficas de parámetros S de FEST con la figura 6.5

También comprobamos que una de las claves de este resultado es que hemos escogi-
do un tamaño para los elementos lo suficientemente pequeño puesto que, si no, nuestra
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gráfica ya no se parece tanto a la de FEST. El hecho de que S11 disminuya con la fre-
cuencia y S12 aumente nos permite ver claramente el comportamiento inductivo del iris,
que corresponde a un filtrado paso alto.

Debido a la simetrı́a que presenta el modo TE10, podemos comprobar como se obtienen
los mismo resultados si partimos la guı́a a través del eje Z y consideramos que la compo-
nente tangente del campo eléctrico es cero en la nueva “pared” de la guı́a. Esto se puede
realizar debido a que el modo TE10 cumple las condiciones de contorno en el plano medio
(paralelo a la dirección de propagación) de la guı́a, es decir, las componentes normales de
campo eléctrico son nulas. Además, este corte nos permitirá ver mejor como se propaga
el modo fundamental a lo largo de la guı́a y reducirá el tiempo de cálculo al contar con la
mitad de incógnitas. El resultado lo podemos ver en la gráfica 6.10.

Figura 6.10: Cortes simétricos de la guı́a en los planos XZ e YZ, siendo Z la dirección de
propagación

Podemos ver como se propaga el campo en el interior de la guı́a haciendo cortes perpen-
diculares a la dirección de propagación (Z), en el plano XY. En la figura 6.11 podemos ver
el campo en en z=-0.026, z=-0.016 y z=0.

Figura 6.11: Cortes simétricos de la guı́a en el plano XY, siendo Z la dirección de propa-
gación

Otra forma de ver el campo es mediante vectores. En el caso de la gráfica 6.12 podemos
ver la parte real del campo eléctrico.
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Figura 6.12: Representación mediantes vectores del campo eléctrico en el plano YZ

En resumen, las conclusiones de este ejemplo son:

• El aumentar el mallado en la zona conflictiva nos ofrece variaciones significativas de
los resultados, lo que indica que el mallado original no aproximaba bien la estructura
a analizar.

• Respecto a la propagación del campo eléctrico vemos cómo se propaga el modo
fundamental a lo largo de la guı́a.

• Según los parámetros S, vemos que para frecuencias bajas el dispositivo a penas
transmite la señal, mientras que para frecuencias altas la transmite casi en su to-
talidad. Es aproximadamente a 12.5GHz cuando S11 se iguala a S12 y la potencia
transmitida es igual a la reflejada y corresponde a la mitad de la potencia de entrada.
Por lo tanto, el estrechamiento actúa como filtro paso alto.

Para ver el ejemplo completo acudir al anexo B.
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6.2.2. TJuntion

En este caso la geometrı́a es una T, es decir, se trata de un dispositivo de 3 puertos
(puerto 0, puerto 1 y puerto 2). Excitaremos al puerto 0 con el modo TE10 y veremos la
transmisión al puerto 2, al 1 y la reflexión en el propio puerto 0.

Figura 6.13: No de puertos

Medimos el campo eléctrico en f = 9GHz (la frecuencia de corte es de 6,5 GHz). El tamaño
máximo de los elementos de la malla será de 0.001m.

Figura 6.14: Variación del campo eléctrico

En la gráfica podemos observar como |E| se transmite del puerto 0 al 2, aunque una
pequeña parte de la onda se propaga al puerto 1.

Respecto a los parámetro S, nos interesa S11, porque es la potencia reflejada, S13, que es
la potencia que se transmite del puerto 1 al 3, y S12 que es la potencia que se transmite
del puerto 1 al 2 y que, en este caso, es mucho menor. Vemos que las gráficas de FEST
y ERMES son iguales.

Este tipo de estructura en forma de T es una red de tres puertos que puede utilizarse para
dividir o combinar potencia. En nuestro caso se usará para transmitir señal principalmente
del puerto 0 al 2 a una frecuencia entre 7 y 12 GHz.

Para ver el ejemplo completo acudir al anexo C.
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Figura 6.15: Gráfica de parámetros S de ERMES, TJuntion

Figura 6.16: Gráfica de parámetros S de FEST, TJuntion
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6.2.3. Guı́a de onda con una transici ón de altura constante

En este ejemplo, medimos el campo eléctrico en f = 15GHz, que es una frecuencia lige-
ramente superior que la frecuencia de corte, y escogemos un tamaño máximo de los ele-
mentos de la malla de 0,002m (valor inferior a λ/10). Indicamos en la figura 6.17 qué puer-
to es el de entrada y cual el de salida.

Figura 6.17: Puertos de entrada y salida

Observamos el campo obtenido en la figura 6.18. También podemos ver como varı́a este
campo si alejamos los puertos al doble de distancia (figura 6.19), o si los acercamos
reduciendo esa distancia a la mitad (figura 6.20).

Figura 6.18: Variación del campo eléctrico Figura 6.19: |E| si alejamos los puertos

Figura 6.20: |E| si acercamos los puertos

Tomamos de nuevo la gráfica de parámetros S de FEST como referencia y la compara-
mos con los resultados de ERMES en el caso general (figura 6.21), en el caso en que
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alejamos el puerto de salida al doble de distancia (en este caso, solo alargamos el puerto
de salida,no el de entrada, ası́, los puertos pasarán de estar a una distancia de 20mm
a una de 30mm) , y en el caso en que acerquemos los puertos a la mitad de distancia
(figura 6.23).

Figura 6.21: Comparativa de las gráficas de parámetros S,resolvemos el mismo ejemplo
con ERMES y FEST (figura 6.18)

En el caso de las gráficas de parámetro S vemos que en los casos en que la estruc-
tura tiene la misma longitud en ERMES y FEST, y en el caso en que alejamos el puerto
de excitación, los resultados coinciden. En el caso en que acercamos los puertos ya no
coinciden los resultados.

Las diferencias que aparecen en el caso de acercar los puertos se deben a la aparición de
los modos evanescentes. La presencia de la transición hace que, aunque la onda incidente
corresponda a un modo TE10, se exciten a ambos lados de la transición otros modos y
que, mientras el modo fundamental se propaga de la forma e− jβz (siendo Z la dirección de
propagación), el resto de modos (los evanescentes) se atenúan de la forma e−αz, tal y co-
mo vimos en el capı́tulo 3, hasta desaparecer a cierta distancia de la transición. Si la guı́a
de ondas es suficientemente larga a ambos lados de la transición, al excitar el modo TE10

en el puerto, sólo veremos este modo en la gráfica de parámetros S, pero si la distancia
no es suficiente, los modos evanescentes no se habrán atenuado y aparecerán en ambos
puertos. Como nosotros hemos introducido las condiciones de contorno suponiendo que
solo está presente el modo TE10 pero vemos que aparecen otros modos, la definición de
los puertos es incorrecta y habrı́a que añadir más términos a las condiciones iniciales.
En resumen, obtenemos malos resultados porque las condiciones de contorno aplicadas
a los puertos (recordemos que se anula la componente normal del campo eléctrico) son
incorrectas y hay que aumentar la distancia de los puertos a la transición para que solo
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Figura 6.22: Comparativa de las gráficas de parámetros S de FEST con la figura 6.19

Figura 6.23: Comparativa de las gráficas de parámetros S de FEST con la figura 6.20

este presente el modo TE10.
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Hay que destacar que en el caso en que alejamos los puertos sólo coincide con la gráfica
de FEST en el caso en que la longitud del puerto estrecho coincidan. Esto es debido
a que el barrido de frecuencia se hace en modo corte para la primera cavidad, y si la
distancia entre este puerto y la discontinuidad es mayor a la simulada por el FEST, el
valor del campo en el plano de proyección se atenúa dando lugar a diferentes valores en
los parámetros de Scattering.

Para ver el ejemplo completo acudir al anexo D.

6.2.4. Guı́a de onda con seis iris inductivos

En este caso aparecen en la guı́a varias cavidades resonantes. Sabemos que la frecuen-
cia de corte del modo fundamental es de 7,5 GHz ası́ que la guı́a no podrá transmitir
información por debajo de esa frecuencia. Hacemos la prueba para una frecuencia de
6GHz y vemos, en la figura 6.24, como el campo ni siquiera pasa de la primera cavidad.

En cambio, para una frecuencia dentro del rango de 8.9 a 9.9 GHz, que es el rango de
frecuencias en el que actua como paso banda, vemos (figura 6.25) como el campo se
propaga por toda la guı́a debido al comportamiento resonante de sus cavidades.

Para frecuencias muy altas, como los 20GHz de la figura 6.26, se propaga no uno sino
varios modos. Esto sucede porque la frecuencia de trabajo es superior a la frecuencia de
corte del modo 20: fc20 = 1

a
√

µε = 14,98GHz.

Figura 6.24: Para f=6GHz el campo no se propaga

Figura 6.25: Para f=9,5GHz el campo se transmite

Figura 6.26: Para f=20GHz se propagan varios modos

Veamos ahora un corte de la estructura (por la mitad) y como se propaga el modo funda-
mental en su interior (figura 6.27):
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Figura 6.27: Corte en la estructura

Sobre las gráficas de parámetro S, nos interesa S11, porque es la potencia reflejada, y
S12, que es la potencia que se transmite. Sabemos que nuestro ejemplo está construido
como un filtro paso-banda entre 8.9 y 9.9 GHz, lo cual podemos ver claramente en las
figuras 6.29 y 6.28.

Figura 6.28: Gráficas de parámetros S

Por la gráfica del parámetro S11 vemos que es un filtro paso banda entre las frecuencias
8,9 y 9,9 MHz debido a que entre esas frecuencias la potencia reflejada es muy baja.
Podemos observar el carácter resonante de cada una de las distintas cavidades y sus
frecuencias centrales.

Este comportamiento del filtro sucede gracias a la intercalación de los irises en la estruc-
tura. Estos irises forman las distintas cavidades en la estructura, que tienen un compor-
tamiento resonante y son las que provocan los ceros de la gráfica de parámetros S.

También podemos observar cómo se desplaza la gráfica hacia la solución correcta al
mallar más fina la estructura (figura 6.30).

Para ver el ejemplo completo acudir al anexo E.
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Figura 6.29: Gráficas de ERMES del parámetro S11

Figura 6.30: Evolución de parámetros S con el mallado, la verde con un mallado más fino

6.2.5. Capacitive Iris

En este ejemplo, medimos el campo eléctrico en f = 14MHz, el barrido de frecuencias
lo hacemos entre 9 y 13MHz y el tamaño máximo de los elementos de la malla será de
0.002m.
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Figura 6.31: Variación del campo eléctrico

Podemos ver como se propaga el campo a lo largo de la guı́a sin problemas, y como el
iris actúa como una cavidad resonante.

Figura 6.32: Comparativa de las gráficas de parámetros S, Capacitive Iris

Vemos que las gráficas de parámetros S obtenidas no se parecen en nada a las del otro
programa de simulación. Esto es debido a una mala formulación del problema [6].

Para ver el ejemplo completo acudir al anexo F.
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6.2.6. Tabla de resultados

Inductive Iris

Resultados esperados Resultados obtenidos Observaciones
El campo eléctrico El campo se El campo tiene
debe propagarse a lo transmite de la la forma de seno
largo de la guı́a. forma esperada. correspondiente

al modo TE10

Sabemos que se trata Los parámetros S11 y S12 Comparamos con otro
de un filtro paso alto coinciden en 12GHz programa y mallamos
con una frecuencia de siendo S12 mayor a partir más el iris para que
corte de 12GHz de dicha frecuencia. el resultado sea mejor.

TJuntion

Resultados esperados Resultados obtenidos Observaciones
Excitamos el puerto 0 Vemos como se Al aumentar la
y esperamos que se transmite señal del frecuencia
propague el campo puerto 0 a los pasa más señal al
hacia los puertos 1 y 2. otros 2 puertos. puerto 2.
Esperamos obtener La gráfica obtenida Si f & fc se reparte la potencia
una gráfica similar es exactamente igual de entrada a los 2 puertos
a la lograda por a la obtenida por por igual. Al aumentar f ,
el programa FEST. el otro programa. cada vez se transmite más

potencia por el puerto 2.

Transici ón de altura constante

Resultados esperados Resultados obtenidos Observaciones
A partir de la fc Efectivamente, nuestros Para un resultado más
esperamos ver como resultados coinciden exacto, mallar más las
se propaga E con los esperados lı́neas de la transición.
Caso general y alejar En ambos casos Al ser f < fc
sólo el puerto de salida: las gráficas vemos que no se
comparar con FEST. coinciden. propaga señal.
Caso de alejar Los resultados Al alejar el puerto de
ambos puertos: no son los entrada y estar en modo de corte,
comparar con FEST. esperados. no llega suficiente señal

a la discontinuidad.
Caso de acercar La gráfica de Acercamos tanto los
los puertos: parámetros S no puertos que los modos
comparar con FEST. coincide con la de FEST. evanescentes no se

han atenuado del todo.
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Estructura con 6 iris

Resultados esperados Resultados obtenidos Observaciones
Esperamos que se Vemos como se Además, el campo
propague el modo TE10 propaga el campo resuena en las
a lo largo de la guı́a. como esperábamos. distintas cavidades.
Se trata de un filtro paso Obtenemos una Vemos la resonancia
banda entre 8,8 y 9,8 GHz. gráfica como la en las cavidades

del otro programa de la estructura.

Capacitive Iris

Resultados esperados Resultados obtenidos Observaciones
Esperamos que se propague Vemos como, Utilizamos una
el campo a lo largo de la efectivamente, tolerancia de 10−6 y
guı́a y que resuene en la el campo cumple un máximo de
cavidad de menor altura. nuestras previsiones iteraciones de 1000.
Respecto a los parámetros S, En este caso, Esto se debe a una
esperamos un comportamiento las gráficas no mala formulación
similar al obtenido coinciden con lo del problema.
por el otro programa. esperado.
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CAPÍTULO 7. CONCLUSIONES

Desglosando y revisando los objetivos indicados en el capı́tulo 2, podemos concluir:

1. Se ha completado la interface del programa ERMES para visualizar de forma más
cómoda los resultados de las guı́as de ondas, en particular, la obtención de las
gráficas de los parámetros S, mediante la creación de la instrucción que las muestra.

2. Se ha creado y aplicado un conjunto de hasta cinco ejemplos que validan el progra-
ma.

3. Se ha completado la documentación existente del programa, tanto en modo de man-
uales, ampliando las secciones de propuesta y validación de ejemplos (capı́tulos 5 y
6), ası́ como incluyendo cinco tutoriales con la resolución de ejemplos paso a paso
(anexos B, C, D, E y F).

Como resultado final, hemos obtenido un paquete de cálculo para la realización de si-
mulaciones de ondas electromagnéticas, con su propia ayuda para utilizar el programa
y ejemplos de uso y validación muy útiles para profundizar en la materia y observar las
aplicaciones de nuestro módulo.

De cara al futuro, este paquete se irá ampliando y abarcando nuevas áreas. La ampliación
más inmediata consiste en poder resolver los problemas mediantes métodos numéricos
hı́bridos como BEM-FEM o GTD-FEM.

Respecto a los resultados obtenidos, hemos observado la propagación a lo largo de di-
ferentes guı́as de onda de sección rectangular y, gracias a nuestro programa, podı́amos
comprobar la naturaleza de su comportamiento (filtro paso alto, paso bajo, paso ban-
do,etc) en el dominio de la frecuencia. Respecto a la geometrı́a, hemos aplicado las condi-
ciones de contorno suponiendo que se propaga sólo el modo fundamental, ası́ que, si los
puertos están tan cerca de la discontinuidad en la guı́a que todavı́a no se han atenuado los
modos evanescentes que se producen en la misma, el resultado será incorrecto porque
no estaremos aplicando bien las condiciones de contorno. Respecto a la malla, cuanto
menor es el tamaño de los elementos, más se aproxima el resultado a la solución real.
Si bien, a partir de un tamaño lo suficientemente pequeño (λ/50), la solución obtenida se
puede considerar muy buena.

En resumen, hemos podido comprobar el correcto funcionamiento del programa en dife-
rentes ejemplos y crear la documentación asociada para el posterior uso de otros estu-
diantes, que era el objetivo principal.
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DIRECTOR: Rub én Otı́n Fortu ño
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APÉNDICE A. ANÁLISIS TEÓRICO

A.1. Obtenci ón del modo TE 10

Consideramos una guı́a de onda rectangular en dirección Z donde las dimensiones de sus
ejes X e Y son a y b respectivamente.

Figura A.1: Guı́a de onda conductora de sección rectangular

De acuerdo a la orientación de la guı́a, y suponiendo que la solución admite separación
de variables, podemos expresar la componente z del campo magnético (la componente z
del campo eléctrico es nula) de la forma:

Hz(x,y) = X(x)Y(y) (A.1)

Sustituyendo en la ecuación (3.15) obtenemos:

Y
∂2X
∂x2 +X

∂2Y
∂y2 +K2

c XY = 0 (A.2)

Si dividimos por XY tenemos que:

1
X

∂2X
∂x2 +

1
Y

∂2Y
∂y2 +K2

c = 0 (A.3)

Para que esta ecuación se cumpla es necesario que tanto 1
X

∂2X
∂x2 como 1

Y
∂2Y
∂y2 tomen valores

constantes, de tal modo que se obtienen las siguientes ecuaciones:

1
X

∂2X
∂x2 +K2

x = 0 (A.4)

1
Y

∂2Y
∂y2 +K2

y = 0 (A.5)

K2
x +K2

y = K2
c (A.6)



Las soluciones generales de las mismas son:

X(x) = AsinKxx+BcosKxx (A.7)

Y(y) = CsinKyy+DcosKyy (A.8)

A partir de estas soluciones generales para la componente longitudinal del campo magnético
se calculan los campo eléctricos y magnéticos transversales con las siguientes ecua-
ciones obtenidas a partir de las ecuaciones de Maxwell:

(ω2µε−β2)Ex = − jωµ
∂Hz

∂y
− jβ

∂Ez

∂x
(A.9)

(ω2µε−β2)Ey = + jωµ
∂Hz

∂x
− jβ

∂Ez

∂y
(A.10)

(ω2µε−β2)Hx = + jωµ
∂Ez

∂y
− jβ

∂Hz

∂x
(A.11)

(ω2µε−β2)Hy = − jωµ
∂Ez

∂x
− jβ

∂Hz

∂y
(A.12)

Aplicando las condiciones de contorno a la superficie de la guı́a las componentes nor-
males de los campos magnéticos en las superficies conductoras han de ser nulos. Para
que esto se cumpla es necesario que:

Hx |x=0,x=a= 0 → A = 0,kx =
mπ
a

Hy |y=0,y=b= 0 → C = 0,ky =
nπ
b

donde, a priori, son posibles cualesquiera valores enteros m,n = 0,1,2,3...

La expresión, por tanto, de la componente longitudinal del campo magnético es:

Hz(x,y) = H0cos

(
mπ
a

x

)
cos

(
nπ
b

y

)
(A.13)

donde hemos definido la amplitud H0 = B·D.

Esta solución corresponde a un modo genérico TEmn, donde los subı́ndices se relacionan
con el ritmo de variación transversal de los campos, en x e y, respectivamente.

La igualdad A.3 puede expresarse ahora mejor:

K2
c = K2

x +K2
y → K2−β2

m,n =
(

mπ
a

)2

+
(

nπ
b

)2

→ βm,n =

√
ω2µε−

(
mπ
a

)2

−
(

nπ
b

)2

(A.14)

Esta expresión, que relaciona la constante de propagación de cada modo con la frecuen-
cia, recibe el nombre de relación de dispersión en la guı́a y nos indica cual es la frecuencia
mı́nima necesaria para que se produzca propagación en la guı́a.
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APÉNDICE B. INDUCTIVE IRIS

B.1. Objetivos de la simulaci ón

Observar la variación del campo eléctrico a lo largo de la guı́a de onda y su compor-
tamiento ante discontinuidades. Además, estudiaremos los parámetros de scattering Si j

y como varı́an en función de cambios en el mallado y la geometrı́a.

El programa de cálculo resuelve las ecuaciones de Maxwell mediante el método de los ele-
mentos finitos y lo aplicamos para resolver problemas 3D en el dominio de la frecuencia.

A continuación estudiaremos un ejemplo.

B.2. Descripci ón del ejemplo

Vamos a analizar el campo eléctrico a lo largo de una guı́a de ondas. Dicha guı́a presenta
un estrechamiento de anchura en su parte central. Esta región estrecha es lo que lla-
mamos iris1. Finalmente, el término inductivo se usa porque su comportamiento respecto
a los planos de la discontinuidad es equivalente a una inductancia.

B.3. Construcci ón del ejemplo

B.3.1. PreProceso

B.3.1.1. Creación del rectángulo

Lo primero de todo es construir la geometrı́a que vamos ha utilizar. En este ejemplo con-
creto habrá que crear dos rectángulos de dimensiones 0,0102 x 0,032 x 0,0229 m, que
son las dos secciones de la guı́a de onda, y otro más estrecho, que será el iris, de dimen-
siones 0,0102 x 0,002 x 0,0229 m. Para crear estos rectángulos usaremos la instrucción
Geometry → Create → Object → Rectangle , entrando por la lı́nea de comandos uno de
los vértices del rectángulo y luego su vértice diagonalmente opuesto. Ası́, iremos creando
todos los rectángulos según las dimensiones que nos dan y, después, con el comando
Geometry → Create → Volume → By contour , crearemos los volúmenes de las 3 cavi-
dades seleccionando las superficies de los rectángulos que las delimitan. El resultado
será una guı́a como la que vemos en la figura B.1.

Seguidamente tenemos que indicarle a GiD que tipo de problema vamos a resolver, que
en nuestro caso va a ser ERMES, ası́ pues, vamos a Data → Problem Type → ERMES,

1El término iris se usa en este contexto para referirse a una apertura que conecta dos secciones de guı́a
de onda



Figura B.1: Geometrı́a

tal como se indica en la figura B.2. ERMES es el módulo de cálculo que nos permitirá ha-
cer las simulaciones. Después, habrá que asignar a nuestra geometrı́a las condiciones
necesarias para que la simulación se realice correctamente.

Figura B.2: Menu

B.3.1.2. Asignación de materiales

Una vez cargado el módulo, dentro del menú Data encontramos el submenú Materials .
En la ventana que aparece debemos seleccionar del menú desplegable el material que
queramos asignar a las superficies y, si no estuviera, deberı́amos crearlo con el botón
“New material”. Una vez creado y seleccionado, tendremos que introducir los parámet-
ros de conductividad eléctrica, permitividad eléctrica y permeabilidad magnética. Ahora
guardamos los parámetros introducidos. En nuestro caso hemos creado el material “Vac-
uum”, para referirnos al aire, y lo hemos asignado a todo el volumen.

Para realizar la asignación de los materiales pulsamos sobre el botón Assign → Volume y
a todos los volúmenes del dibujo que ahora seleccionemos se les asignará el material. Una
vez finalizada la asignación pulsaremos sobre “Finish” o bien pulsaremos el botón central
del ratón. Para comprobar que hemos seleccionado correctamente, podemos visualizar
los materiales asignados con el botón Draw → All materials . Quedará como podemos
ver en la figura B.3.



Figura B.3: Materiales

B.3.1.3. Asignación de condiciones de contorno

En este apartado asignamos cada uno de los puertos de entrada y salida de nuestra
guı́a de onda. Lo primero de todo será introducir las coordenadas XYZ de 3 puntos que
permitan definir los puertos de entrada y salida. Además, a cada puerto se le asignará un
número (type) para indicar si es de entrada o de salida, el puerto de entrada será el 1, el
puerto de salida 1 será el 2, el de salida 2 será el 3,etc. Para ello vamos al menú Data →
Boundary coefficients y aparece una ventana con el nombre de un puerto, su número y
sus coordenadas, que tendremos que rellenar nosotros.

Después, en Data → Fix Electric Field , seleccionamos “Superficies”, ‘‘Electric Field PEC”
y asignamos todas las superficies correspondientes al conductor que forma la guı́a de
onda. De esta manera, asignamos el valor de cero a todo el campo eléctrico tangente a la
guı́a de onda. También en “Superficies”, seleccionamos “Electric Field PMC” y asignamos
las superficies de los puertos de entrada y salida de la onda. En este caso sucede lo
contrario, se trata de un conductor magnético perfecto y el campo eléctrico perpendicular
a la dirección de propagación es cero.

Para acabar este apartado, vamos a Data → Neumman Flux y en “Port Conditions” le
asignamos a la ’Boundary Condition’ del ’Port In’, la superficie correspondiente al puerto
de entrada, y a la “Boundary Condition” del “Port Out1” la superficie del puerto de salida.

Por último, para comprobar que lo hemos hecho bien, dibujamos los puertos como en la
figura B.4.

Figura B.4: Condiciones de contorno

Aún nos falta elegir el plano o corte en el que queremos observar los resultados. Para



ello vamos a Data → Modes proyection , y asignamos los puertos correspondientes de
nuevo.

B.3.1.4. Establecimiento de los parámetros del problema

Los parámetros que aún no hemos introducido son la frecuencia, la manera que vamos a
resolver las ecuaciones diferenciales que rigen la naturaleza del problema y los resultados
que queremos obtener y representar. Empezamos con Data → Problem Data y en la ven-
tana que nos ha aparecido, elegimos “Frequency: custom” y añadimos el valor 9 ·109Hz.
Si queremos que haga un barrido en frecuencia, por ejemplo, para visualizar los pará-
metros S, seleccionamos la casilla “Frecuency sweep”. En caso de que queramos hacer
el barrido de frecuencia tenemos que indicar la frecuencia inicial, la final y cada cuánto
tomamos un valor, p.ej.: “Initial Freq: 7e9”, “Final Freq: 12e9” y “Step Freq: 0.2e9”,con
esto indicamos que el barrido comienza en 7GHz, acaba en 12GHz, y toma valores cada
200MHz. También marcamos “Max Iterations: 1e+4”, “Tolerance: 1e-6”, “PreConditioner:
Identity”. Seleccionamos “Accept” y “Close”.

Figura B.5: Frecuencias
Figura B.6: Solvers iterativos

Una vez hecho esto, tenemos que indicar cuales son los resultados que queremos ob-
servar. Vamos a Data → Results . Marcamos todos los resultados debajo de la pestaña
“Frequency Domain Output” porque queremos obtener todos los componentes del campo
eléctrico en el dominio de la frecuencia. Por otro lado, cambiamos a la pestaña de “Time
Domain Output” y activamos “Results in Time” para ver los resultados en el dominio del
tiempo. Dejamos las opciones por defecto (“Max Number of Save Results: 1000”, “Initial
Time: Time Increment”, “Final Time: T”, “Time Increment: T/32” ) y el campo eléctrico. Es-
tos resultados después los podremos visualizar e incluso animar. Le damos a “Accept” y
“Close”.

B.3.1.5. Creación de la malla

Una vez asignados todos los materiales y todas las condiciones de contorno ya estamos
en condiciones para crear la malla.

Para llevarlo a cabo nos vamos a Mesh → Generate mesh . Ahora nos aparecerá una
ventana emergente donde debemos introducir el tamaño máximo de los elementos, en
este caso 0,001, le damos a “OK”, entonces nos preguntará si queremos borrar la malla



Figura B.7: Resultados en el dominio del
tiempo

Figura B.8: Resultados en el dominio de la
frecuencia

anterior, a lo que diremos que sı́, y la malla empezará a generarse. A la hora de elegir
el tamaño de los elementos de la malla, hemos de tener en cuenta que el programa
debe disponer de suficientes puntos de cálculo como para poder resolver el problema,
atendiendo a las consideraciones geométricas, estos puntos deben encontrarse a una
distancia tı́pica no superior a λ

10 .Una vez generada aparecerá un cuadro de diálogo que
nos informará del número de elementos y nodos que se han generado.

Figura B.9: Generar la malla

Figura B.10: Elementos

Figura B.11: Malla

Además de esto, también podemos refinar el mallado en los puntos, lı́neas o superficies
que nos interese. En nuestro caso, por ejemplo, podrı́amos afinar el mallado en las super-
ficies que forman el iris.

Para el mallado de puntos tenemos que ir al menu Mesh → Unstructure → Points , en
el caso de lı́neas será Mesh → Unstructure → Lines y en el de superficies Mesh →
Unstructure → Surfaces .

Para nuestro ejemplo mallaremos más finas las lı́neas que forman el iris.



El resto de pasos se suceden de la misma manera tanto para puntos como para lı́neas o
superficies. El programa pregunta el tamaño de los elementos, igual que sucedı́a antes en
el mallado general. Si seguimos con el ejemplo de las lı́neas podemos poner, por ejemplo,
0,001.

Después, habra que seleccionar los elementos que queremos mallar a ese tamaño, y
cuando los tengamos seleccionados pulsar ESC para salir de la aplicación. Para finalizar,
realizaremos el mallado de la pieza tal y como hemos hecho antes.

El programa, antes de mallar, nos preguntará si queremos borrar la malla anterior, a lo
que responderemos que sı́, y, después, el tamaño de los elementos de la malla. Nosotros
pondremos 0.002, y OK. Ahora el programa generará la malla tal y como nosotros le
hemos indicado, podremos ver en la figura B.13 como el número de nodos es mucho
mayor en la zona del iris que es la zona donde hemos seleccionado las ĺıneas con un
tamaño de elementos menor.

Figura B.12: Mallar lı́neas con otro tamaño Figura B.13: Nuevo mallado

B.3.2. Simulaci ón

Ahora ya estamos en disposición de realizar la simulación propiamente dicha.

Para ello vamos a Calculate →Calculate 2. También podemos comprobar el funcionamien-
to del proceso con Calculate → View process info , en esta ventana aparecerı́an los
errores si los hubiera. Además nos permite ver si el Solver iterativo escogido tiende a
converger o a diverger. En caso de tender a la divergencia, es decir, se aleja de la tole-
rancia, podemos terminar el proceso y cambiar el Solver. Para parar el proceso basta ir a
Calculate → Cancel process .

Una vez conseguida la convergencia y terminada la escritura de los resultados apare-
cerá una ventana indicándolo, momento en el cual presionaremos sobre PostProcess.

2La duración del proceso depende de la cantidad de memoria disponible en el ordenador, ası́ como del
procesador del mismo; a más memória y más CPU, menos tiempo.



B.3.3. PostProceso

B.3.3.1. Campo eléctrico

Lo primero que vamos a hacer es abrir las ventanas de View Results, View Style y Animate
con Windows → View Results , Windows → View Style y Windows → Animate . Con
estas ventanas podemos cambiar la forma de ver el resultado.

Con la ventana View Style podemos cambiar los colores de la geometrı́a, si queremos
ver solo el contorno, lı́neas, puntos,etc. Con View Results elegimos el resultado que
queremos observar, por ejemplo, el módulo del campo eléctrico en el contorno de la pieza,
o la componente x del campo en toda la guı́a,etc. Y, por último, una vez tengamos todo
lo anterior, podemos abrir la ventana Animate y al darle a play animaremos el resultado
escogido. Las gráficas obtenidas se pueden ver en el capı́tulo 6 donde realizamos la
validación del iris.

B.3.3.2. Parámetros S

Una vez estemos en el postproceso y, habiendo seleccionado el barrido de frecuencia para
el cálculo, aparece en la barra de herramientas de ERMES un nuevo botón llamado S. Al
presionar dicho botón aparece en pantalla una gráfica con los valores de los parámetros
Si j correspondientes al barrido de frecuencia elegido.

Figura B.14: Estilo Figura B.15: Vista de los
resultados

Figura B.16: Animación de
los resultados
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APÉNDICE C. TJUNTION

C.1. Objetivos de la simulaci ón

Observar la variación del campo eléctrico a lo largo de una guı́a rectangular que se bifurca
en 2 puertos de salida. Además, estudiaremos sus parámetros de dispersión y como varı́a
en función de cambios en el mallado y la geometrı́a.

El programa de cálculo resuelve las ecuanciones de Maxwell mediante el método de los
elementos finitos y lo aplicamos para resolver problemas 3D en el dominio de la frecuen-
cia.

A continuación estudiaremos un ejemplo.

C.2. Descripci ón del ejemplo

Vamos a analizar el campo eléctrico a lo largo de una guı́a de ondas con la forma de la
figura C.1 y su transmisión. En este caso la geometrı́a es una T, es decir, se trata de un
dispositivo de 3 puertos, puerto 0, puerto 1 y puerto 2. Excitaremos al puerto 0 con el
modo TE10 y veremos la transmisión al puerto 2, al 1 y la reflexión.

Figura C.1: No de puertos

C.3. Construcci ón del ejemplo

C.3.1. Creaci ón del rect ángulo

Lo primero de todo es construir la geometrı́a que vamos a utilizar. En este ejemplo cons-
truiremos primero el cuadrado central de lado 22.9 mm, y después, los tres rectángulos



de 22.9 x 30 mm unidos a tres de los cuatro lados del cuadrado central. Posteriormente
les daremos volumen con una altura de 5.08 mm y quedará un dibujo como el de la figura
C.2 de una guı́a en forma de T en la que entra la onda por un puerto que se propaga hacia
otro y se transmite una parte por el tercero.

Figura C.2: Geometrı́a

Después cargamos el problem type ERMES, que es el módulo de cálculo que nos permi-
tirá hacer las simulaciones.

C.3.2. Asignaci ón de materiales

Una vez cargado el problem type, tenemos que asignar los materiales. Asignamos el aire
(Vacuum) a todos los volúmenes del dibujo:

Figura C.3: Materiales

C.3.3. Asignaci ón de condiciones de contorno

En este apartado asignamos cada uno de los puertos de entrada y salida de nuestra
guı́a de onda. Lo primero de todo será intruducir las coordenadas XYZ de 3 puntos que
permitan definir los puertos de entrada y salida. Además, a cada puerto se le asignará un
número (type) para indicar si es de entrada o de salida, el puerto de entrada será el 1, el
puerto de salida 1 será el 2 y el de salida 2 será el 3. En la ventana “Boundary coefficients”
introducimos el nombre de cada puerto, su número y sus coordenadas.



Figura C.4: Coeficientes del puerto 0

Después, en la ventana “Electric Conditions”, asignamos el valor de campo eléctrico nu-
lo. En el caso de un conductor eléctrico perfecto (superficie de la guı́a), para el campo
tangente a la misma, y, en el caso de un conductor magnético perfecto (puertos), para el
campo perpendicular a la superficie del puerto.

Para acabar este apartado, vamos a “Boundary conditions” asignamos las condiciones de
contorno de los puertos al puerto que les corresponda en el dibujo.

Por último, para comprobar que lo hemos hecho bien, dibujamos los puertos como en la
figura C.5.

Figura C.5: Condiciones de contorno

Aún nos falta elegir el plano o corte en el que queremos observar los resultados. Para ello,
en “Modes proyection”, podemos asignar los puertos correspondientes de nuevo.

C.3.4. Establecimiento de los par ámetros del problema

Los parámetros que aún no hemos introducido son la frecuencia, la manera que vamos a
solucionar las ecuaciones diferenciales que rigen la naturaleza del problema y los resulta-
dos que queremos obtener y representar.

Buscamos la frecuencia de corte del modo fundamental como referencia:

fc10 =
1

2a
√

µε
= 6,55GHz (C.1)



En la ventana “Problem Data” escogemos como frecuencia de trabajo 9GHz para ver el
campo eléctrico, o bien haremos un barrido de frecuencias entre 7 y 12GHz para ver la
gráfica de parámetros S.

C.3.5. Creaci ón de la malla

Una vez asignados todos los materiales y todas las condiciones de contorno ya estamos
en condiciones para crear la malla.

Para éste problema hemos escogido una frecuencia de 9Ghz lo que nos lleva a una lon-
gitud de onda:

λ =
vp

f
=

1
f
√

µε
= 33,31062641mm

Para el mallado se escogió un tamaño máximo de los elementos de 0.001m, valor inferior
al valor máximo de λ/10.

Figura C.6: Malla
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APÉNDICE D. GUÍA DE ONDA CON UNA
TRANSICIÓN DE ALTURA CONSTANTE

D.1. Objetivos de la simulaci ón

Observar la variación del campo eléctrico a lo largo de la guı́a de onda y su comportamien-
to ante una transición de altura constante. Además, estudiaremos también sus parámetros
de scattering o parámetros S.

El programa de cálculo resuelve las ecuaciones de Maxwell mediante el método de los ele-
mentos finitos y lo aplicamos para resolver problemas 3D en el dominio de la frecuencia.

A continuación estudiaremos un ejemplo.

D.2. Descripci ón del ejemplo

Vamos a analizar el campo eléctrico a lo largo de una guı́a de ondas. Dicha guı́a es una
guı́a de sección rectangular que se enchancha en su parte final mantiniendo la altura
constante. Miraremos como se propaga el campo a lo largo de la guı́a y los parámetros
S11 y S12 de los puertos.

D.3. Construcci ón del ejemplo

D.3.1. Creaci ón del rect ángulo

Lo primero de todo es construir la geometrı́a que vamos ha utilizar.

En este ejemplo construiremos primero el paralelepı́pedo rectangular grande, de dimen-
siones 22.86mm x 10.16mm x 10mm (ancho x alto x largo), y después el pequeño de
11.43mm x 10.16mm x 10mm, colocado justo en medio de la cara frontal del otro rectángu-
lo, tal y como indica la figura D.1.

D.3.2. Asignaci ón de materiales

Cargamos el problem type ERMES y ya podemos empezar a asignar propiedades. Em-
pezamos con los materiales y asignamos el aire (Vacuum) a todos los volúmenes del
dibujo.



Figura D.1: Geometrı́a

Figura D.2: Materiales

D.3.3. Asignaci ón de condiciones de contorno

En este apartado asignamos cada uno de los puertos de entrada y salida de nuestra guı́a
de onda. Lo primero de todo será intruducir las coordenadas XYZ de 3 puntos que per-
mitan definir los puertos de entrada y salida. Además, a cada puerto se le asignará un
número (type) para indicar si es de entrada o de salida, el puerto de entrada será el
“PortIn1” y el puerto de salida será el 2. En la ventana “Boundary coefficients” introduci-
mos el nombre de cada puerto, su número y sus coordenadas.

Después, en la ventana “Electric Conditions”, asignamos el valor de campo eléctrico nu-
lo. En el caso de un conductor eléctrico perfecto (superficie de la guı́a), para el campo
tangente a la misma, y, en el caso de un conductor magnético perfecto (puertos), para el
campo perpendicular a la superficie del puerto.

Para acabar este apartado, vamos a “Boundary conditions” asignamos las condiciones de
contorno de los puertos al puerto que les corresponda en el dibujo.

Por último, para comprobar que lo hemos hecho bien, dibujamos los puertos como en la
figura D.3.

Aún nos falta elegir el plano o corte en el que queremos observar los resultados. Para ello,



Figura D.3: Condiciones de contorno

en “Modes proyection”, podemos asignar los puertos correspondientes de nuevo.

D.3.4. Establecimiento de los par ámetros del problema

Los parámetros que aún no hemos introducido son la frecuencia, la manera que vamos a
resolver las ecuaciones diferenciales que rigen la naturaleza del problema y los resultados
que queremos obtener y representar.

Buscamos la frecuencia de corte del modo fundamental como referencia:

fc10 =
1

2a
√

µε
= 13,15GHz (D.1)

En la ventana “Problem Data”, escogemos como frecuencia de trabajo 14GHz para ver
el campo eléctrico, o bien haremos un barrido entre 7 y 12GHz para comparar nuestra
gráfica de parámetros S con la simulada por otro software.

D.3.5. Creaci ón de la malla

Una vez asignados todos los materiales y todas las condiciones de contorno ya estamos
en condiciones para crear la malla.

Para éste problema hemos escogido una frecuencia de 14GHz lo que nos lleva a una
longitud de onda:

λ =
vp

f
=

1
f
√

µε
= 0,022798147m

Para el mallado se escogió un tamaño máximo de los elementos de 0,001, valor inferios
al valor máximo de λ/10. Hemos obtenido 6542 nodos.



Figura D.4: Malla
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APÉNDICE E. GUÍA DE ONDA CON SEIS IRIS
INDUCTIVOS

E.1. Objetivos de la simulaci ón

Observar la variación del campo eléctrico a lo largo de la guı́a de onda y su comportamien-
to ante la presencia de cavidades resonantes. Además, estudiaremos sus parámetros de
Scattering y como varı́an en función de cambios en el mallado y la geometrı́a.

El programa de cálculo resuelve las ecuaciones de Maxwell mediante el método de los ele-
mentos finitos y lo aplicamos para resolver problemas 3D en el dominio de la frecuencia.

A continuación estudiaremos un ejemplo.

E.2. Descripci ón del ejemplo

Vamos a analizar el campo eléctrico a lo largo de una guı́a de ondas. Dicha guı́a consiste
en cinco cavidades que actuan como resonadores, unidos entre ellos y a la guı́a mediante
los irises o estrechamientos de la guı́a. Ası́, la respuesta en frecuencia dependerá de las
dimensiones de dichas cavidades y los iris. Esta estructura ha sido diseñada para trabajar
como un filtro paso-banda entre las frecuencias de 8.8 y 9.8 GHz.

E.3. Construcci ón del ejemplo

E.3.1. Creaci ón del rect ángulo

Lo primero de todo es construir la geometrı́a que vamos ha utilizar. Consideramos un
filtro de seis ı́rises inductivos de dimensiones aproximadas de ≈ 20 x 2 x 1 cm. Más
concretamente, nuestro dominio computacional viene dado por Ω = Ω1− (Ω2 + Ω3 +
Ω4 +Ω5 +Ω6 +Ω7)

E.3.2. Asignaci ón de materiales

Asignamos el aire (Vacuum) a todos los volúmenes del dibujo.



Figura E.1: Geometrı́a completa de la estructura

Figura E.2: Materiales

E.3.3. Asignaci ón de condiciones de contorno

En este apartado asignamos cada uno de los puertos de entrada y salida de nuestra
guı́a de onda. Lo primero de todo será intruducir las coordenadas XYZ de 3 puntos que
permitan definir los puertos de entrada y salida. Además, a cada puerto se le asignará un
número (type) para indicar si es de entrada o de salida, el puerto de entrada será el 1, el
puerto de salida 1 será el 2 y el de salida 2 será el 3. En la ventana Boundary coefficients



introducimos el nombre de cada puerto, su número y sus coordenadas.

Después, en la ventana “Electric Conditions”, asignamos el valor de campo eléctrico nu-
lo. En el caso de un conductor eléctrico perfecto (superficie de la guı́a), para el campo
tangente a la misma, y, en el caso de un conductor magnético perfecto (puertos), para el
campo perpendicular a la superficie del puerto. Tenemos que asegurarnos que lo hemos
asignado bien y que la guı́a sigue hueca para poder transmitir la información. Deberı́a
quedar un agujero como el que muestra la figura E.3

Figura E.3: Condiciones de contorno

Para acabar este apartado, vamos a “Boundary conditions” asignamos las condiciones de
contorno de los puertos al puerto que les corresponda en el dibujo.

Por último, para comprobar que lo hemos hecho bien, dibujamos los puertos como en la
figura E.4.

Figura E.4: Condiciones de contorno

Aún nos falta elegir el plano o corte en el que queremos observar los resultados. Para ello,
en “Modes proyection”, podemos asignar los puertos correspondientes de nuevo.

E.3.4. Establecimiento de los par ámetros del problema

Los parámetros que aún no hemos introducido son la frecuencia, el modo empleado para
resolver las ecuaciones diferenciales que rigen la naturaleza del problema y los resultados
que queremos obtener y representar.

Buscamos la frecuencia de corte del modo fundamental como referencia:

fc10 =
1

2a
√

µε
= 13,15GHz (E.1)



En la ventana “Problem Data”, escogemos como frecuencia de trabajo 9GHz para ver el
campo eléctrico, o bien haremos un barrido de frecuencias para ver la gráfica de paráme-
tros S entre 8.8 y 10GHz, que es el rango de frecuencias en el que nuestra estructrura
actúa como filtro.

E.3.5. Creaci ón de la malla

Una vez asignados todos los materiales y todas las condiciones de contorno ya estamos
en condiciones para crear la malla.

Para éste problema hemos escogido una frecuencia de 9Ghz lo que nos lleva a una lon-
gitud de onda:

λ =
vp

f
=

1
f
√

µε
= 0,015603294m

Para el mallado se escogió un tamaño máximo de los elementos de 0,001, valor inferior al
valor máximo de λ/10. Se obtienen 83814 nodos.
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APÉNDICE F. CAPACITIVE IRIS

F.1. Objetivos de la simulaci ón

Observar la variación del campo eléctrico a lo largo de la guı́a de onda y su compor-
tamiento ante un estrechamiento de la altura en su parte central. Además, estudiaremos
también sus parámetros de scattering o parámetros S.

El programa de cálculo resuelve las ecuaciones de Maxwell mediante el método de los ele-
mentos finitos y lo aplicamos para resolver problemas 3D en el dominio de la frecuencia.

A continuación estudiaremos un ejemplo.

F.2. Descripci ón del ejemplo

Vamos a analizar el campo eléctrico a lo largo de una guı́a de ondas. Dicha guı́a presenta
un estrechamiento de altura en su parte central. Esta región estrecha es lo que llamamos
iris1.

F.3. Construcci ón del ejemplo

F.3.1. Creaci ón del rect ángulo

Lo primero de todo es construir la geometrı́a que vamos ha utilizar.

En este ejemplo construiremos primero el paralelepı́pedo rectangular grande, de dimen-
siones 22.86mm x 10.16mm x 10mm (ancho x alto x largo), y después el pequeño de
11.43mm x 10.16mm x 20mm, colocado justo en medio de la cara frontal del otro rectángu-
lo, tal y como indica la figura F.1:

F.3.2. Asignaci ón de materiales

Cargamos el problem type ERMES y ya podemos empezar a asignar propiedades. Em-
pezamos con los materiales y asignamos el aire (Vacuum) a todos los volúmenes del
dibujo.

1El término iris se usa en este contexto para referirse a una apertura que conecta dos secciones de guı́a
de onda



Figura F.1: Geometrı́a

Figura F.2: Materiales

F.3.3. Asignaci ón de condiciones de contorno

En este apartado asignamos cada uno de los puertos de entrada y salida de nuestra guı́a
de onda. Lo primero de todo será intruducir las coordenadas XYZ de 3 puntos que per-
mitan definir los puertos de entrada y salida. Además, a cada puerto se le asignará un
número (type) para indicar si es de entrada o de salida, el puerto de entrada será el
“PortIn1” y el puerto de salida será el 2. En la ventana “Boundary coefficients” introduci-
mos el nombre de cada puerto, su número y sus coordenadas.

Después, en la ventana “Electric Conditions”, asignamos el valor de campo eléctrico nu-
lo. En el caso de un conductor eléctrico perfecto (superficie de la guı́a), para el campo
tangente a la misma, y, en el caso de un conductor magnético perfecto (puertos), para el
campo perpendicular a la superficie del puerto.

Para acabar este apartado, vamos a “Boundary conditions” asignamos las condiciones de
contorno de los puertos al puerto que les corresponda en el dibujo.

Por último, para comprobar que lo hemos hecho bien, dibujamos los puertos como en la
figura F.3.

Figura F.3: Condiciones de contorno



Aún nos falta elegir el plano o corte en el que queremos observar los resultados. Para ello,
en “Modes proyection”, podemos asignar los puertos correspondientes de nuevo.

F.3.4. Establecimiento de los par ámetros del problema

Los parámetros que aún no hemos introducido son la frecuencia, la manera a emplear
para resolver las ecuaciones diferenciales que rigen la naturaleza del problema y los re-
sultados que queremos obtener y representar.

Buscamos la frecuencia de corte del modo fundamental como referencia:

fc10 =
1

2a
√

µε
= 13,15GHz (F.1)

En la ventana “Problem Data”, escogemos como frecuencia de trabajo 14GHz para ver
el campo eléctrico, o bien elegimos un barrido entre 9 y 15GHz para comparar nuestra
gráfica de parámetros S con la simulada por otro software.

F.3.5. Creaci ón de la malla

Una vez asignados todos los materiales y todas las condiciones de contorno ya estamos
en condiciones para crear la malla.

Para éste problema hemos escogido una frecuencia de 14Ghz lo que nos lleva a una
longitud de onda:

λ =
vp

f
=

1
f
√

µε
= 0,022798147m

Para el mallado se escogió un tamaño máximo de los elementos de 0.001, valor inferior al
valor máximo de λ/10.
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APÉNDICE G. CÓDIGO TCL

TCL (Tool Command Language) es un lenguaje de programación interpretado y multi-
plataforma. Fue creado por John K. Ousterhout y su equipo de la Universidad de Cali-
fornia, pero actualmente es desarrollado por Sun Microsystems Laboratories (en concre-
to por su gupo SunScript, que lidera el propio Ousterhout) y distribuido de forma total-
mente gratuita, aunque su uso sea para aplicaciones comerciales, a través de Internet.
El intérprete puede ser encontrado en diversas direcciones, pero seguramente, la más
rápida es la del servidor FTP de la Escuela Técnica Superior de Ingenieros de Minas de
Oviedo.

http://www.etsimo.uniovi.es/pub/tcl/

TCL es un lenguaje de comandos, cuyo intérprete recibe el nombre de Tclsh (tclsh80
para TCL/TK 8.0), que tiene como una de sus principales caracterı́sticas la gran faci-
lidad con la que se pueden implementar funciones en C/C++ que pasan a ser nuevas
instrucciones del intérprete. Es decir, se pueden embeber aplicaciones en C/C++ dentro
del propio intérprete de TCL; de esta forma es posible obtener nuevas versiones de TCL,
denominadas extensiones, que no dejan de ser otra cosa que intérpretes que aunan a los
comandos originales de TCL nuevos comandos escritos en C/C++.

Algunas de estas extensiones son BLT (que permite hacer representaciones gráficas en
2D), Itcl (Incremental TCL, TCL orientado a objetos), OraTcl (TCL capaz de manejar bases
de datos ORACLE), etc.

Pero sin duda, la extensión más conocida, y que es distribuida junto con el propio TCL,
es TK (Tool Kit). TK, creada por el propio John Ousterhout, proporciona un intérprete de-
nominado wish (para TCL/TK 8.0, wish80), que añade a los comandos de TCL comandos
capaces de crean interfaces gráficos de usuario. Es decir, TK permite crear ventanas,
botones, menús, barras de scroll, y toda una serie de elementos, propios de la progra-
mación con ventanas. A todos estos elementos los denomina widgets.

TK se distribuye junto con TCL en un paquete denominado TCL/TK, que proporciona los
dos intérpretes citados anteriormente. El intérprete de TCL puede ser eliminado ya que
se encuentra incorporado en el intérprete de TK.

Ventajas de TCL/TK:

• Sencillez de programación.

• Rapidez en el desarrollo de las aplicaciones.

• Gran velocidad comparado con otros lenguajes interpretados.

• Facilidad de modificación de las aplicaciones.

• Multiplataforma.

• Gran número de extensiones gratuitas.

• Posibilidad de incorporar nuevos comandos en lenguaje C/C++.



Inconvenientes de TCL/TK:

• Excesivamente lento comparado con los lenguajes compilados.

• Necesidad del intérprete para ejecutar una aplicación.

• Difı́cil de depurar, debido a que, a diferencia de un compilador, el intérprte sólo
”traduce.el código que se ejecuta; pudiendo quedar partes del código sin depurar
porque el intérprete nuca las haya ejecutado.

Veamos ahora el código completo en TCL de ERMES:

# kratos0.1.tcl -- TCL --
# Kratos Team - 2004
#www.kratos.cimne.upc.es
#—————————————————————————
# This file is written in TCL lenguage
# For more information about TCL look at: http://www.sunlabs.com/research/tcl/
# # At least two procs must be in this file:
# # InitGIDProject dir - Will be called whenever a project is begun to be used.
# where dir s the project’s directory
# EndGIDProject - Will be called whenever a project ends to be used.
# # For more information about GID internals, check the program scripts.
#—————————————————————————

proc ErmesBitmaps { dir { type "DEFAULT INSIDELEFT"} } {
global BitmapsNamesPre ErmesBitmapsCommandsPre ErmesBitmapsHelpPre ErmesPriv
global BitmapsNames ErmesBitmapsCommands ErmesBitmapsHelp

set ErmesBitmapsNamesPre(0) "../images/Help.gif --- \
../images/Materials.gif \
../images/Boundary.gif \
../images/Flux.gif \
../images/BoundCondS.gif \ --- \
../images/BoundCond.gif \
../images/Pressure.gif \
../images/Source.gif \ --- \
../images/Displacement.gif
../images/Data.gif \
../images/Results.gif --- \
../images/Mesh.gif \
../images/Compute.gif --- \
../images/ermes.gif"

set ErmesBitmapsCommandsPre(0) [list \
[list -np- HelpWindow "CUSTOM_HELP_FILE"[file join $dir ../html/index.html]]\
[list ""] \
[list -np- GidOpenMaterials Materials] \



[list -np- GidOpenMaterials Boundary_Coefficients] \
[list -np- GidOpenMaterials Voltage_Coefficients] \
[list -np- GidOpenMaterials FD_Sources] \
[list ""] \
[list -np- GidOpenConditions Electric_Conditions] \
[list -np- GidOpenConditions Boundary_Conditions] \
[list -np- GidOpenConditions Electromagnetic_Sources] \
[list ""] \
[list -np- GidOpenConditions Modes_Proyection] \
[list -np- GidOpenProblemData Solving_Strategy] \
[list -np- GidOpenProblemData Results] \
[list ""] \
"Meshing generate" \
"Utilities Calculate" \
[ list ""] \
[list -np- WebPageKratos $ErmesPriv(Web)]

]
set ErmesBitmapsHelpPre(0) { "About ERMES . . ." "" \
"Material Properties" \
"Boundary Coefficients"\
"Voltage Coefficients"\
"FD Sources" "" \
"Fixed Electric Field" \
"Boundary Flux" \
"Electromagnetic Sources" "" \
"Modes Proyection" \
"Solving Strategy" \
"Results" "" "" \
"Generate Mesh" \
"Calculate" ""\
"Kratos WebPage"}

set ErmesBitmapsNames(0) "../images/Help.gif --- \
../images/Materials.gif \
../images/Boundary.gif \
../images/Flux.gif \
../images/BoundCondS.gif \ --- \
../images/BoundCond.gif \
../images/Pressure.gif \
../images/Source.gif \ --- \
../images/Displacement.gif
../images/Data.gif \
../images/Results.gif --- \
../images/Mesh.gif \
../images/Compute.gif --- \
../images/S.gif --- \
../images/ermes.gif"



set ErmesBitmapsCommands(0) [list \
[list -np- HelpWindow "CUSTOM_HELP_FILE" [file join $dir ../html/index.html]] \
[list ""] \
[list -np- GidOpenMaterials Materials] \
[list -np- GidOpenMaterials Boundary_Coefficients] \
[list -np- GidOpenMaterials Voltage_Coefficients] \
[list -np- GidOpenMaterials FD_Sources] \
[list ""] \
[list -np- GidOpenConditions Electric_Conditions] \
[list -np- GidOpenConditions Boundary_Conditions] \
[list -np- GidOpenConditions Electromagnetic_Sources] \
[list ""] \
[list -np- GidOpenConditions Modes_Proyection] \
[list -np- GidOpenProblemData Solving_Strategy] \
[list -np- GidOpenProblemData Results] \
[list ""] \
"Meshing generate" \
"Utilities Calculate" \
[list ""] \
[list -np- ErmesReadGraph] \
[list ""] \
[list -np- WebPageKratos $ErmesPriv(Web)]

]
set ErmesBitmapsHelp(0) { "About ERMES . . ." "" \
"Material Properties" \
"Boundary Coefficients"\
"FD Sources" "" \
"Fixed Electric Field" \
"Boundary Flux" \
"Electromagnetic Sources" "" \
"Modes Proyection" \
"Solving Strategy" \
"Results" "" \
"Generate Mesh" \
"Calculate" ""\
"Scattering Parameters" "" \
"Kratos WebPage"}

# prefix values:
# Pre Only active in the preprocessor
# Post Only active in the postprocessor
# PrePost Active Always
set prefix Post
set ErmesPriv(toolbarwin) [CreateOtherBitmaps ErmesBar [= "Ermes toolbar"] \

ErmesBitmapsNames ErmesBitmapsCommands \
ErmesBitmapsHelp $dir "ErmesBitmaps [list $dir]" $type $prefix]

AddNewToolbar "Ermes bar" ${prefix}ErmesBarWindowGeom \
"ErmesBitmaps [list $dir]"



set prefix Pre
set ErmesPriv(toolbarwin) [CreateOtherBitmaps ErmesBarPre [= "Ermes toolbar"] \

ErmesBitmapsNamesPre ErmesBitmapsCommandsPre \
ErmesBitmapsHelpPre $dir "ErmesBitmaps [list $dir]" $type $prefix]

AddNewToolbar "Ermes bar" ${prefix}ErmesBarWindowGeom \
"ErmesBitmaps [list $dir]"

proc EndErmesBitmaps {} {
global ErmesPriv
ReleaseToolbar "Ermes bar"
rename ErmesBitmaps ""
catch { destroy $ErmesPriv(toolbarwin) }

}

Hasta aqui hemos creado las barras de herramientas de ERMES para el pre- y postpro-
ceso (son diferentes ya que en el postproceso aparecen los parámetros S) y ahora le
asignaremos una función a cada uno de los botones que las componen. En la figura G.1
vemos la barra de herramientas del preproceso y destacamos algunas funciones impor-
tantes.

Figura G.1: Barra de herramientas de ERMES

proc InitGIDProject { dir } {
global MenuNames MenuEntries MenuCommands MenuAcceler
global MenuNamesP MenuEntriesP MenuCommandsP MenuAccelerP
global ErmesPriv



global GidUtils
set ErmesPriv(ProgramName) "ERMES"
set ErmesPriv(VersionNumber) 0.1
set ErmesPriv(Web) "http://www.cimne.com/kratos/emant"
set GidVersion [.gid.central.s info GiDVersion]
set GidVersion [string trim $GidVersion]
set GidVersion [string index $GidVersion 0]

if { $GidVersion < 7 } {
WarnWin [_ "%s v%s is not compatible with GiD version lower than 7" \

$ErmesPriv(ProgramName) $ErmesPriv(VersionNumber)]
return
}

Splash $dir 2501

set ipos [lsearch $MenuNames Help]
if { $ipos != -1 } {
set MenuEntries($ipos) [linsert $MenuEntries($ipos) 0 \
[_ "%s v%s Help" $ErmesPriv(ProgramName) $ErmesPriv(VersionNumber)] --- ]

set MenuCommands($ipos) [linsert $MenuCommands($ipos) 0 \
[list -np- HelpWindow "CUSTOM_HELP_FILE" \
[file join $dir ../html/index.html]] ""]

set MenuAcceler($ipos) [linsert $MenuAcceler($ipos) 0 ""]

lappend MenuEntries($ipos) \
[_ "About %s v%s" $ErmesPriv(ProgramName) $ErmesPriv(VersionNumber)] --- \
[_ "%s WebPage" $ErmesPriv(ProgramName)]

lappend MenuCommands($ipos) [list -np- Splash $dir] ""
[list -np- WebPageKratos $ErmesPriv(Web)]
lappend MenuAcceler($ipos) ""
UpdateMenus
}

set ipos [lsearch $MenuNamesP Help]
if { $ipos != -1 } {
set MenuEntriesP($ipos) [linsert $MenuEntriesP($ipos) 0 \

[_ "%s v%s Help" $ErmesPriv(ProgramName) $ErmesPriv(VersionNumber)] --- ]
set MenuCommandsP($ipos) [linsert $MenuCommandsP($ipos) 0 \

[list -np- HelpWindow "CUSTOM_HELP_FILE" \
[file join $dir ../html/index.html]] ""]

set MenuAccelerP($ipos) [linsert $MenuAccelerP($ipos) 0 ""]
lappend MenuEntriesP($ipos) \

[_ "About %s v%s" $ErmesPriv(ProgramName) $ErmesPriv(VersionNumber)]
lappend MenuCommandsP($ipos) [list -np- Splash $dir]
lappend MenuAccelerP($ipos) ""
UpdateMenus
}



ErmesBitmaps $dir
GidChangeDataLabel "Data units" ""
GidChangeDataLabel "Interval" ""
GidChangeDataLabel "Conditions" ""
GidChangeDataLabel "Materials" ""
GidChangeDataLabel "Problem Data" ""
GidChangeDataLabel "Local axes" ""
GidAddUserDataOptions "---" "" 2
GidAddUserDataOptions "Materials" "GidOpenMaterials Materials" 3
GidAddUserDataOptions "Boundary Coefficients" "GidOpenMaterials
Boundary_Coefficients" 4
GidAddUserDataOptions "Voltage Coefficients" "GidOpenMaterials
Voltage_Coefficients" 5
GidAddUserDataOptions "FD Sources" "GidOpenMaterials FD_Sources" 6
GidAddUserDataOptions "---" "" 7
GidAddUserDataOptions "Fixed Electric Field" "GidOpenConditions
Electric_Conditions" 8
GidAddUserDataOptions "Neumann Flux" "GidOpenConditions
Flux_Contour_Conditions" 9
GidAddUserDataOptions "---" "" 10
GidAddUserDataOptions "Current Sources" "GidOpenConditions
Electromagnetic_Sources" 11
GidAddUserDataOptions "---" "" 12
GidAddUserDataOptions "Modes Proyection" "GidOpenConditions
Modes_Proyection" 13
GidAddUserDataOptions "Problem Data" "GidOpenProblemData
Solving_Strategy" 14
GidAddUserDataOptions "Results" "GidOpenProblemData Results" 15
}

proc EndGIDProject {} {
EndErmesBitmaps

}

proc WebPageKratos { dir } {
global ErmesPriv
VisitWeb $dir

}

proc HelpOnkratos { dir } {
global ErmesPriv
WarnWin [_ "To obtain help for %s v%s, check the lates news in %s" \
$ErmesPriv(ProgramName) $ErmesPriv(VersionNumber) $ErmesPriv(Web)]

}

proc Splash { dir { TimeOut 0 } } {
global GIDDEFAULT



if { [.gid.central.s disable windows] } { return }
if { [ winfo exist .splash]} {
destroy .splash
update
}

toplevel .splash

set im [image create photo -file [ file join $dir ../images/Ermes-3DFW.gif]]
set x [expr [winfo screenwidth .splash]/2-[image width $im]/2]
set y [expr [winfo screenheight .splash]/2-[image height $im]/2]

wm geom .splash +$x+$y
wm transient .splash .gid
wm overrideredirect .splash 1
pack [label .splash.l -image $im -relief ridge -bd 2]

bind .splash <1> "destroy .splash"
bind .splash <KeyPress> "destroy .splash"
raise .splash .gid
grab .splash
focus .splash
update

if { $TimeOut > 0 } {
after $TimeOut "if { [ winfo exist .splash] } { destroy .splash }"
}

}

proc ErmesReadGraph { } {
set filename [file join [GiD_Info project ModelName].gid S11.dat]
GiD_Process Mescape results graphs readgraph $filename escape
set filename2 [file join [GiD_Info project ModelName].gid S12.dat]
GiD_Process Mescape results graphs readgraph $filename2 escape
set filename3 [file join [GiD_Info project ModelName].gid S13.dat]
GiD_Process Mescape results graphs readgraph $filename3 escape

}

Esta última función (ErmesReadGraph) lee los archivos S11 y S12 del modelo que este-
mos calculando y muestra por pantalla la gráfica de parámetros S, tal y como muestra la
figura G.2:



Figura G.2: Gráfica de los parámetro S


